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SI* (MODERN METRIC) CONVERSION FACTORS 
APPROXIMATE CONVERSIONS TO SI UNITS 

Symbol When You Know Multiply By To Find Symbol 
LENGTH 

in  inches 25.4 millimeters mm 
ft  feet 0.305 meters m 
yd  yards 0.914 meters m 
mi  miles 1.61 kilometers km 

AREA 
in2  square inches 645.2 square millimeters mm2 
ft2  square feet 0.093 square meters m2 
yd2  square yard 0.836 square meters m2 
ac  acres 0.405 hectares ha 
mi2  square miles 2.59 square kilometers km2 

VOLUME 
fl oz  fluid ounces 29.57 milliliters mL 
gal  gallons 3.785 liters L 
ft3  cubic feet 0.028 cubic meters m3 
yd3  cubic yards 0.765 cubic meters m3 

NOTE: volumes greater than 1000 L shall be shown in m3 

MASS 
oz  ounces 28.35 grams g 
lb  pounds 0.454 kilograms kg 
T  short tons (2000 lb) 0.907 megagrams (or "metric ton") Mg (or "t") 
oz  ounces 28.35 grams g 

TEMPERATURE (exact degrees) 
oF  Fahrenheit 5 (F-32)/9 

or (F-32)/1.8 
Celsius oC 

FORCE and PRESSURE or STRESS 
lbf  poundforce 4.45   newtons N 
lbf/in2  poundforce per square inch 6.89 kilopascals kPa 

APPROXIMATE CONVERSIONS FROM SI UNITS 
Symbol When You Know Multiply By To Find Symbol 

LENGTH 
mm  millimeters 0.039 inches in 
m  meters 3.28 feet ft 
m  meters 1.09 yards yd 
km  kilometers 0.621 miles mi 

AREA 
mm2  square millimeters 0.0016 square inches in2 
m2  square meters 10.764 square feet ft2 
m2  square meters 1.195 square yards yd2 
ha  hectares 2.47 acres ac 
km2  square kilometers 0.386 square miles mi2 

VOLUME 
mL  milliliters 0.034 fluid ounces fl oz 
L  liters 0.264 gallons gal 
m3  cubic meters 35.314 cubic feet ft3 
m3  cubic meters 1.307 cubic yards yd3 
mL  milliliters 0.034 fluid ounces fl oz 

MASS 
g  grams 0.035 ounces oz 
kg  kilograms 2.202 pounds lb 
Mg (or "t")  megagrams (or "metric ton") 1.103 short tons (2000 lb) T 
g  grams 0.035 ounces oz 

TEMPERATURE (exact degrees) 
oC  Celsius 1.8C+32 Fahrenheit oF 

FORCE and PRESSURE or STRESS 
N  newtons 0.225 poundforce lbf 
kPa  Kilopascals 0.145 poundforce per square inch lbf/in2 
*SI is the symbol for the International System of Units. Appropriate rounding should be made to comply with Section 4 of ASTM E380. (Revised March 2003) 
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Abbreviation Term 
AGL Above Ground Level 
AgTS ArgenTech Solutions 
ANSI American National Standards Institute 
AWRF Acoustic Weather Research Facility 
B&K Brüel & Kjær (acoustic equipment manufacturer) 
CARS CompactRIO Acoustic Recording System 
CFR Code of Federal Regulations 
CORS Continually Operating Reference Station 
COTS Commercial/Consumer Off-the-Shelf 
CPA Closest Point of Approach 
DJI Dà-Jiāng Innovations (UA manufacturer) 
FAA Federal Aviation Administration 
GNSS Global Navigation Satellite System 
GPS Global Positioning System 
IPP Integrated Pilot Program 
JBCC Joint Base Cape Cod 
LAE Sound Exposure Level (SEL) 
LASmx Maximum A-weighted Level, slow response (LAMax) 
LAeq Equivalent Continuous Sound Level (LEQ) 
LD Larson Davis (acoustic equipment manufacturer) 
MASSDOT Massachusetts Department of Transportation 
NAS National Airspace System 
NI National Instruments (acoustic equipment manufacturer) 
PTH Pressure time-history 
SD Sound Designs (acoustic equipment manufacturer) 
SLM Sound Level Meter 
START Survey and Tracking Apparatus for Research in Transportation 
UA Unconventional Aircraft 
USDOT United States Department of Transportation 
VTOL Vertical Takeoff and Landing 

 Introduction 
The Volpe Unconventional Aircraft (UA) Noise Research Team, in support of the Federal Aviation 
Administration’s (FAA) Office of Environment and Energy noise division AEE-100, has been conducting and 
facilitating UA noise measurements for approximately 7 years. The purpose of these noise measurements 
has been to gather data to characterize the acoustic signatures of various types of UA, which can then be 
used to inform noise policy and regulations, encourage the development of specific aircraft designs, and 
highlight operations that may be acoustically relevant to the communities around proposed flight paths. 
 
The primary purpose of this measurement campaign at Joint Base Cape Cod (JBCC) was to capture robust 
acoustics, tracking, and weather data to be used by FAA AEE-100 to inform and assist in the development 
of environmental assessments for proposed UA operations in and around communities in the United 
States. An additional goal was to share the collected data (after appropriate anonymization) with fellow 
government, industry researchers, and academic research teams to facilitate knowledge transfer and 
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collaboration amongst all stakeholders. 
 
This report can be viewed as a continuation of the work done by the Volpe UA Noise Research Team in 
July 2019 as part of the UAS Integration Pilot Program at the Choctaw Nation test site near Daisy, 
Oklahoma1. There are many similarities between the Choctaw measurement campaign and this effort at 
JBCC, such as aircraft types, operations, and core data types. There have also been many improvements 
and changes made to the measurement hardware, software, and operations to fit the requirements 
provided by FAA AEE-100, driven by the present-day UA noise landscape. 
 
The acoustic measurements took place at the Aviation Weather Research Facility (AWRF) grounds at JBCC 
in Falmouth, Massachusetts from September 27th through October 1st, 2021. Data were captured for five 
UA platforms. Over the course of five measurement days, the Volpe UA Noise Research Team collected 
high-quality acoustics, tracking, and weather data for over 300 individual flight events, distributed over 
the four aircraft with loaded and unloaded weights ranging from 1.4kg to 31.7kg, including various multi-
rotor platforms, as well as a large fixed-wing / VTOL hybrid platform.  
 
The initial results of the acoustic measurement are included in this report. Additional reports may include 
more detailed analyses of the recorded data as more data are collected in future measurements 
campaigns.  
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  Measurement Description 
2.1 Measurement Team Members and Partners 

2.1.1 Volpe UA Noise Research Team 

The Volpe UA Noise Research team comprises approximately a dozen people, mostly staff members of 
the Environmental Measurement & Modeling Division at the U.S. DOT’s Volpe National Transportation 
Systems Center (Volpe Center). The team is currently led by Dave Read and Chris Cutler-Wood, and is 
focused on gathering data and presenting information to assist in the development and understanding of 
UA noise, community impacts of UA operations, and potential regulatory frameworks. The Volpe UA Noise 
Research Team previously collected the noise, tracking and meteorological data at the Choctaw Nation of 
Oklahoma IPP site in July 2019. The team meets bi-weekly to discuss ongoing data analysis and planning 
for future measurement campaigns as directed by the primary sponsor, FAA/AEE. 

2.1.2 Consortiq 

Consortiq, based in Annapolis, Maryland and London, U.K. is a global, unmanned data aerial vehicle 
consulting, training and data collection service provider, specializing in more unusual and complex use 
cases within hazardous environments. Consortiq provided the vehicles and operators for the JBCC 
measurements. 

2.1.3 ArgenTech Solutions 

ArgenTech Solutions, Inc. (AgTS) is a New Hampshire (NH) based, veteran-owned, small business. AgTS 
has extensive experience and competence in managing complex technical services 24/7, world-wide, in 
support of Unmanned Aircraft Systems (UAS), services for the US Department of Defense (DOD).  In 
partnership with Consortiq, AgTS provide additional vehicles and operators for the JBCC measurements. 

2.2 Measurement Site 

2.2.1 AWRF Site History and Background 

The Aviation Weather Research Facility (AWRF) is a 155-acre parcel of land located on JBCC. The site is 
managed by the Volpe Center’s Aviation Weather & PNT Applications Division (V-345) with funding from 
the Federal Aviation Administration. The AWRF site has been a valuable Volpe asset for over 30 years, 
most notably for the validation and verification of a wide variety of complex atmospheric and 
meteorological sensors that measure visibility, rainfall, wind, and cloud ceiling. The AWRF site has also 
supported unconventional aircraft operational activities, most recently hosting the UA GPS Backup 
Demonstration, which involved flights of multiple UA platforms and GNSS tracking systems for the 
purpose of testing the relative precision and accuracy of the tracking systems. The AWRF site includes a 
dedicated building with electricity, heat, running water, and internet, and can be accessed by team 
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members at any time of day or night. The building served as a primary UA vehicle staging and secure 
storage area for the measurement campaign. 

2.2.2 Historical Meteorological Analysis 

As part of the initial measurement site scoping process, a meteorological analysis was undertaken for the 
AWRF site to demonstrate the probability of acceptable weather conditions, specifically wind speed and 
wind direction, during the targeted measurement timeframe of May through October. Historical 
meteorological data from a permanent, continuously-operational Vaisala WXT-520 weather sensor at the 
AWRF site was analyzed to produce bi-hourly averages for selected weather metrics for each month within 
the measurement timeframe. These meteorological data were cross-referenced and compared with 
publically available METAR reports from the local KFMH (Cape Cod Coast Guard Air Station) at JBCC to 
ensure nominal accuracy. A sample of the analysis is shown below in Figure 1 and Figure 2. 
 

 
Figure 1 - AWRF Wind Speed Analysis, August 
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Figure 2 - AWRF Wind Direction Analysis, August 

 
Upon review of the meteorological data, it was concluded that the AWRF site had an acceptable 
probability of suitable weather conditions for the proposed UA noise measurements in the May through 
October timeframe. It was also observed that, on average, weather conditions tend to be more favorable 
in the early morning through the early afternoon (0600 – 1000 local). The full meteorological analysis can 
be found in Appendix F. 

2.2.3 Preliminary Site Scoping (APR2021, AUG2021) 

Due to the proposed measurement site’s relative proximity to the Volpe Center (an approximate 1 hour 
and 30-minute drive from Cambridge, MA), Volpe UA Noise Research Team members were able to visit 
the AWRF grounds for two separate site scoping trips.  
 
The first trip occurred on Monday April 12, 2021, and was supported by Volpe employees from both V-
324 and V-345. During the first site scoping, the team assessed the overall feasibility of the site with 
respect to ambient noise sources, available flight area, building amenities, and potential options for 
erecting an elevated microphone array. Although the weather conditions during this site visit were sub-
optimal, the site was determined to be an acceptable option for the UA noise measurement campaign. 
Requests were submitted to the AWRF site managers to coordinate the expansion of on-site mowed areas 
in order to support installation of acoustic arrays and supporting equipment. 
 
The second site scoping trip took place on Wednesday and Thursday August 18-19, 2021, after the site 
had officially been chosen to host the UA noise measurement campaign. The second site scoping trip 
allowed Volpe team members to survey all relevant measurement locations, including microphone array 
locations, nominal flight path end points, as well as the acoustics station and crane positions. The 
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surveying process included both the physical measurement of distances from the measurement array 
origin and the collection of stable, raw satellite data at each measured position using a laptop, u-blox 
software, and uBlox NEO-M8T High Gain GPS receiver. The surveyed positions were physically marked 
with stakes and flagging tape. These surveyed positions served as permanent locations for the upcoming 
noise measurement campaign, as well as any potential, subsequent measurements at the AWRF. By 
means of leaving permanent markers, the site scoping survey saved approximately 5-6 hours of field time 
per future measurement. In addition to the survey activities, the second site scoping allowed the Volpe 
personnel to confirm the availability of particular on-site hardware, tools, and other materials to inform 
the final pack list for the September 2021 measurement campaign. Figure 3 shows a satellite image of the 
surveyed AWRF site (outlined in yellow), the nominal flight path (red line), and proposed center of the 
microphone array (blue cross). 
 

 
Figure 3 - Preliminary AWRF measurement site layout 

2.3 Measurement Layout and Design 

The development and implementation of the microphone arrays was influenced by existing guidance for 
military jet and commercial helicopter source noise measurement campaigns. The primary goal of the 
array design was to capture acoustic data that could be used to create noise “spheres”, or three-
dimensional representations of the aircraft source noise for different flight conditions. These noise 
spheres can be used in acoustic modeling programs to simulate the various potential noise impacts in 



 
         JBCC UA Noise Measurement Report    18 

communities based on particular operational parameters. In order to gather the necessary acoustic data 
for noise sphere generation, it was important to position the microphones in such a way as to capture the 
noise from the aircraft at many different emission angles. The acoustic emission angle is the angle created 
by the straight line from the center of the aircraft to the microphone position relative to the horizon at a 
given point in time. Due to the anticipated low signal-to-noise ratio of these aircraft, it was recommended 
that the team use a microphone array consisting of both a ground-plane microphone array and a vertical, 
elevated microphone array, to capture additional emission angles without increasing the slant range, or 
acoustic path length from the aircraft to the microphone position. 
Figure 4 presents a plan view including the ground microphone array, the nominal UA vehicle flight track 
for flyover operations, the nominal hover location for hover operations, as well as the location of the 
elevated array. Figure 5 shows an aerial view of the fully deployed microphone arrays during the JBCC 
measurement campaign (taken from the DJI M210 onboard camera system), with ground microphone 
positions circled in black, and elevated mic positions identified with yellow arrows. The combined 
deployed microphone arrays comprised a total of 21 microphone positions: 14 ground-plane, 5 elevated, 
and 2 ancillary positions, described in the following sections. Due to input channel constraints, data was 
actively collected at a total of eighteen microphones positions at any point during the measurements. 
 

 
Figure 4 - Simplified Microphone Position Diagram 

 

Hover Location 

Flight Track 
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Figure 5 - Deployed JBCC microphone arrays, aerial view 

2.3.1 Ground-Plane Microphone Array 

The ground-plane microphone array comprised 14 total microphones, arranged in a linear pattern 
(primarily for flyover operation data collection) and a circular pattern (primarily for hover operation data 
collection). All ground positions were surveyed in the site scoping visits prior to the measurement 
campaign. A ground plate was installed at each position by clearing a shallow patch of soil, placing the 
ground plate at the center, and filling in the soil around the plate to create a smooth ground-to-plate 
transition and minimize any acoustical artifacts caused by acoustical impedance differences and/or edge 
diffraction. A sample of a completed ground plate installation can be seen in Figure 6. 
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Figure 6 - Ground plate installation with microphone 

2.3.2 Vertical, Elevated Microphone Array 

To facilitate the elevated array, the team designed a 110 ft. mounting apparatus comprising three 
connected caving ladders and custom-built mounting arms for the microphones and associated cabling. 
Microphones were installed and calibrated while on the ground, and the completed rig was then gently 
hoisted into the air and hung vertically by a construction crane on site. A sample of a deployed elevated 
microphone installation can be seen in Figure 7. 
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Figure 7 - Elevated microphone array with DJI M600 in background 

2.3.3 Ancillary Microphone Positions 

At the request of FAA AEE, the Volpe UA Noise Research Team deployed microphones at two additional 
measurement locations, separate from the main measurement array. Each position employed a B&K 4189 
microphone, PRM831 preamplifier, a Roland RD-05 digital audio recorder to record audio data, and an 
LD831 class 1 sound level meter to capture live noise level metrics. Microphones were mounted on 4 ft. 
tripods at both of these positions and oriented for grazing incidence, as opposed to the inverted, ground 
plate installation for the main ground array. 
 
One of the ancillary positions was a far “sideline” position, approximately 450 feet from the F000 
microphone position on the East microphone axis. This position was intended to capture acoustical data 
for the purpose of investigating the lateral attenuation of the UA noise signatures. 
 
The other ancillary microphone was co-located with the existing F45W position for the purpose of 
enabling direct comparison between the acoustical data captured with the ground plate installation 
versus the 4 ft. tripod installation. 

2.4 Unconventional Aircraft 
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The Consortiq and ArgenTech teams supplied a total of 10 unconventional aircraft for the noise 
measurement campaign. The aircraft represented a wide variety of configurations, sizes, flight mechanics, 
and power sources, ranging from small commercial-off-the-shelf vehicles to large, custom-built hybrid 
aircraft capable of hours-long operations well above 5,000 ft. AGL. The aircraft are listed and described in 
this section, along with relevant specifications and photos. Of the ten total aircraft made available for this 
measurement campaign, acoustics and tracking data were captured during operations of five aircraft, 
which are described in the following sub-sections. The relevant specifications for each of the five 
measured aircraft can be found in Tables 1 and 2. 

2.4.1 ArgenTech FireEye Series 2 

The ArgenTech FireEye Series 2 is a hybrid powered, vertical takeoff and landing (VTOL) and fixed-wing 
aircraft. The aircraft has a MTOW of 31.7kg, a maximum airspeed of 54 knots, and a maximum operational 
time of approximately 3 hours.  During takeoffs and landings, the aircraft is controlled by eight electrically 
powered rotors. The aircraft transitions to forward flight using a gasoline powered pusher propeller to 
gain forward airspeed and utilizes standard flight surfaces for control. The aircraft was flown on Friday 
October 1, 2021. 
 

 
Figure 8 - ArgenTech FireEye Series 2 on Landing Pad 

 

2.4.2 ALTI UAS Transition 

The ALTI UAS Transition is a hybrid powered, vertical takeoff and landing (VTOL) and fixed-wing aircraft. 
The aircraft has a MTOW of 18kg, a maximum airspeed of 51 knots, and a maximum operational time of 
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approximately 3 hours. During takeoffs and landings, the aircraft is controlled by four electrically powered 
rotors. The aircraft transitions to forward flight using a gasoline powered pusher propeller to gain forward 
airspeed and utilizes standard flight surfaces for control. The aircraft was flown on Tuesday September 
28, 2021, and Wednesday 29SEP2021. 
 

 
Figure 9 - ALTI Transition on Landing Pad 

2.4.3 DJI Matrice 600 

The DJI Matrice 600 (M600) is an electrically powered six-rotor aircraft. The aircraft has a MTOW of 15.1kg, 
a maximum airspeed of 18 meters per second, and a maximum operational time of approximately 35 
minutes. For this measurement campaign, the aircraft was flown with the landing legs continuously 
deployed (unfolded). The M600 was flown on the four measurement days between Monday September 
27, 2021 and Thursday September 30, 2021. 
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Figure 10 - DJI M600 Prepared for Takeoff at JBCC 

2.4.4 DJI M210 V2 RTK 

The DJI Matrice 210 (M210) is an electrically powered four-rotor aircraft. The aircraft has a MTOW of 
6.14kg, a maximum airspeed of 49.5 miles per hour, and a maximum operational time of approximately 
35 minutes. For this measurement campaign, the aircraft was flown with the landing legs continuously 
deployed (unfolded). The M210 was flown on the three measurement days between Wednesday 
September 29, 2021 and Friday October 1, 2021. 
 

 
Figure 11 - DJI M210 V2 RTK during Takeoff 

2.4.5 DJI Phantom 4 Pro 
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The DJI Phantom 4 Pro (P4P) is an electrically powered four-rotor aircraft. The aircraft has a MTOW of 
1.6kg, a maximum airspeed of 45 miles per hour, and a maximum operational time of approximately 30 
minutes.  This aircraft has fixed landing legs. The M210 was flown on the two measurement days, Thursday 
September 30, 2021 and Friday October 1, 2021. 
 

 
Figure 12 -DJI Phantom 4 Pro with START System Installed 

2.4.6 Vehicle Specifications 

Specifications for each vehicle were collected from the vehicle operators prior to the measurement 
campaign and reduced into a simplified table for quick reference and use in the flight card development 
process. The Vehicle specifications tables are shown below in Tables 1 and 2. Please note that, due to 
differences in manufacturer reports, the units for speed and weight parameters may vary between 
aircraft. 
 

Table 1 - Specifications for the AgT FIreEye & ALTI Transition 

Vehicle Information ArgenTech 
FireEye Series 2 

ALTI UAS 
Transition 

Parameter Definition Value Units Value Units 

Weight 
Empty Weight 26.6 kg 11.8 kg 
Max Weight 31.7 kg 18 kg 
Max Payload 3.5 kg 1.5 kg 



 
         JBCC UA Noise Measurement Report    26 

Velocity 

Vmax 54 kts 51 kts 
Vcruise 45 kts 43 kts 
Vmin 40 kts 31 kts 

Voperational 45 kts 43 kts 

Altitude 

Flyover Low 500 ft 150 ft 
Flyover High 750 ft 300 ft 
Hover Low 10 ft 10 ft 
Hover High 75 ft 75 ft 
Operational 1000 ft 600 ft 

 
Table 2 - Specifications for DJI Aircraft (M600, M210, and P4P) 

Vehicle Information DJI M600 DJI M210 V2 RTK DJI Phantom 4 
Pro 

Parameter Definition Value Units Value Units Value Units 

Weight 
Empty Weight 9.1 kg 4.8 kg 1375 g 
Max Weight 15.1 kg 6.14 kg 1600 g 
Max Payload 6 kg 1.2 kg 225 g 

Velocity 

Vmax 18 m/s 45.9 mph 45 mph 
Vcruise 10 m/s 12.5 mph 12.5 mph 
Vmin 5 m/s 7.5 mph 7.5 mph 

Voperational 18 m/s 12.5 mph 12.5 mph 

Altitude 

Flyover Low 50 ft 50 ft 50 ft 
Flyover High 100 ft 100 ft 100 ft 
Hover Low 2 ft 2 ft 2 ft 
Hover High 50 ft 50 ft 50 ft 
Operational 400 ft 400 ft 400 ft 
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2.5 Flight Test Procedures 

The flight test procedures for this measurement campaign were influenced by the procedures of previous 
flight tests such as those conducted at the Choctaw Nation IPP site in July 2019, and those conducted in 
Liberty, NC in July 2021. In all cases, the flight test procedures were meant to represent both steady-state 
flight conditions (for the purposes of evaluating relationships between the flight parameters and the 
acoustic signature), and operational flight conditions (to accurately characterize the aircraft noise as it 
may be experienced in real-world operation). To accommodate this, the flight test procedures included 
takeoff, landing, hover, and level flyover events at varying speeds, altitudes, and aircraft takeoff weights. 
The specific values for these flight parameter variables were determined on an individual aircraft basis, 
depending on the specific operational and physical constraints of each platform (found in Tables 1 and 2). 

2.5.1 Flight Card Development 

To organize the flight test procedures for all aircraft, it was necessary to create flight cards for each 
platform with standardized naming convention (“Test ID”) for all possible flight events. A summary table 
of flight events can be seen in Table 3. These Test IDs were used throughout the measurement to 
communicate upcoming and completed flight events between the acoustics and flight teams. A physical 
flight card was printed for each aircraft, specific to its operational capabilities, and was used to confirm 
the appropriate number of successful events were captured. It was decided that 6 acceptable events (3 in 
each flight direction) per Test ID would be sufficient for data analysis. 
 
Table 3 - Flight Card Summary 

TEST ID Condition Weight Speed Altitude 
F01 Level Flyover Max Weight Vmax Flyover Low 
F02 Level Flyover Max Weight Vmax Flyover High 
F03 Level Flyover Empty Weight Vmax Flyover Low 
F04 Level Flyover Empty Weight Vmax Flyover High 
F05 Level Flyover Max Weight Vcruise Flyover Low 
F06 Level Flyover Max Weight Vcruise Flyover High 
F07 Level Flyover Empty Weight Vcruise Flyover Low 
F08 Level Flyover Empty Weight Vcruise Flyover High 
F09 Level Flyover Max Weight Vmin Flyover Low 
F10 Level Flyover Max Weight Vmin Flyover High 
F11 Level Flyover Empty Weight Vmin Flyover Low 
F12 Level Flyover Empty Weight Vmin Flyover High 
H01 Hover Max Weight - Hover High 
H02 Hover Empty Weight - Hover High 
H03 Hover Max Weight - Hover Low 
H04 Hover Empty Weight - Hover Low 
V01 Idle - Ground Idle Ground 
V02 Takeoff Max Weight Vcruise Ground to Flyover Low 
V03 Takeoff Empty Weight Vcruise Ground to Flyover Low 
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V04 Landing Max Weight Vcruise Flyover Low to Ground 
V05 Landing Empty Weight Vcruise Flyover Low to Ground 
V06 Level Flyover Max Weight Voperational Operational 
V07 Level Flyover Empty Weight Voperational Operational 

 
  
  



 
         JBCC UA Noise Measurement Report    29 

  Measurement Instrumentation and Data 
Acquisition Procedures 

3.1 Acoustic Data Collection System 

3.1.1 Acoustic Data Collection Hardware 

The primary acoustic data collection system used for this measurement campaign was the CompactRIO 
Acoustic Recording System (CARS). This system comprised two data acquisition nodes, based on NI model 
cRIO-9037 controllers. Each node was powered by a pair of 18-20 amp-hour, 12-volt sealed lead-acid 
batteries and accepted 8 microphone inputs that were fed through two gain amplifiers (B&K Nexus 2693, 
4 channels each). The amplifiers provided DeltaTron a current supply to power the DeltaTron 
preamplifiers as well as provide selectable gain to the incoming signal. Each gain amplifier was powered 
by a sealed lead-acid battery. Each input channel of the gain amplifiers was connected to a 
microphone/preamplifier pair: a pre-polarized, pressure-response microphone (GRAS 40AO) connected 
to a B&K 2671 DeltaTron microphone pre-amplifier. Each recording node used an NI-9467 model GPS time 
synchronization module connected to a GPS antenna to set and synchronize recording node system times 
to UTC. In addition, each recording node had a channel dedicated to recording the amplitude modulated 
IRIG-B signal from Master Clock GPS200A time code generators. Analog-to-digital conversion was done 
using either NI-9250 or NI-9232 modules, at a rate of 102,400 samples per second and 24-bit precision. 
Microphone and IRIG-B signals were written to files on a 500 GB solid state drive local to each recording 
node. Each node was connected to a network switch which was connected to a field laptop to control the 
recording node via LabVIEW. A diagram of the complete signal chain for each node is shown in Figure 27. 
Figure 13 shows the connected field setup of both data acquisition nodes of CARS. 
 

 
Figure 13 - CARS Nodes 
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Cables were run from all microphone positions to the end of the van used to house the acoustics 
equipment. The full CARS setup in Figure 14 shows the sealed lead-acid batteries behind the two data 
acquisition nodes, as well as the four gain amplifiers and field laptop. 
 

 
Figure 14 - Full CARS Setup with Acoustics Lead 

3.1.2 Acoustics Data Measurement Software 

Control of the acoustic data acquisition system was accomplished using in-house software developed in 
the NI LabVIEW environment, version 2017. The software was designed to provide flexibility in 
measurement configuration and monitoring, and also as a platform for electronic logging and tasks such 
as calibration. As part of software setup, the user is required to input information on nominal or stated 
microphone sensitivity, signal gain applied by Nexus amplifiers, and linear operating range of the full 
system for the specified configuration. To aid in field setup, those input settings are supplied via ASCII 
input files which were pre-generated for these measurements. Furthermore, the user has an option to 
start the software using the last set of measured microphone sensitivities. During operation, the software 
provides a display of ½-second levels for each channel, a time history plot of those levels, and a 1/3rd 
octave band spectrum display generated using the ANSI-compliant NI Sound and Vibration toolkit. 
Examples are shown in Figures 15 and 16. The user has the option of applying different time averaging 
and frequency weighting, though it is important to note that those options apply to displayed levels only; 
primary recorded data are microphone signals with no averaging or frequency weighting applied. In 
addition to level displays, the CARS software also provides a live signal display – a modulated IRIG-B signal 
is shown in Figure 17. 
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Figure 15 - An example of the live display of the CARS software 

 

 
Figure 16 - 1/3rd octave band display in CARS software 
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Figure 17 - CARS software signal display (IRIG-B signal shown) 

Following software startup, the general procedure was to use the time synchronization modules to set 
CARS system times to UTC. System times were used to timestamp the starting point of raw recorded files, 
and starting times of the processed acoustic data files came from post-processed IRIG-B recordings made 
simultaneously with each event. Pretest microphone calibration routines were also software-based. In 
addition to setting microphone sensitivity, 10-second duration recordings of calibration signals were made 
for each channel. Post-test calibration checks were completed in a similar manner. 
 
As part of typical test sequences, the acoustic measurement system operator initiated data recording on 
both nodes, either following a signal from the test director (“data on”), or in anticipation of such a signal. 
In the case of early recording initiation, data were trimmed to the actual “data on” time. Data recording 
was stopped following a signal from the test director (“data off”). Following this sequence, the acoustic 
measurement system operator signaled the acoustics support field technician that data files were closed 
and the downloading of files from the recording nodes to the second laptop could be initiated as part of 
post-event data quality checks. In addition to real-time monitoring and start/stop of data recording, the 
measurement system software was also used to electronically log timestamped operator comments to an 
ASCII file. 
 
Acoustic data quality checks were performed alongside recording events to ensure the quality and 
completeness of the acquired data. Following recording of each event, a program was run on a second 
laptop to automatically download the last set of recorded files from each node. The acoustics support 
field technician then ran a Matlab script to generate unweighted (Z-weighted) and A-weighted 
spectrogram plots for each microphone signal. An example of one such plot is shown in Figure 18. The 
technician also listened to recordings from each microphone. These checks were intended to catch 
problems specific to each microphone channel such as insect noise or hardware malfunction, and ensured 
data quality somewhat in real-time throughout the measurement day.  
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Figure 18 - Example of data quality check plot 

3.2 “START” Tracking System 

Time-space-position-information (TSPI) for each aircraft tested at JBCC was provided by the Survey and 
Tracking Apparatus for Research in Transportation (START) system. START is a GNSS-based vehicle tracking 
and surveying platform developed by Volpe for the purpose of deriving precise positioning information 
from UAS and other automated vehicles. The development and implementation of this system was to 
ensure high quality, accessible TSPI data for all aircraft, independent of exterior configuration and internal 
GPS hardware and software limitations. Often times, the internal GPS systems for UA platforms do not 
collect position data at a great enough precision or resolution for the purposes of noise measurement 
analysis. Even if the internal systems collect data of adequate quality, the data they collect is often only 
accessible through proprietary software tools that vary between manufacturers and operator platforms 
(if accessible at all). The Volpe START system eliminates much of the uncertainty related these disparate 
and inaccessible systems and provides consistent, high-quality tracking data. 
 
START comprises primarily consumer off-the-shelf (COTS) products that have been configured for the 
purpose of collecting and storing satellite observations suitable for applying carrier-phase based 
corrections via post process kinematic (PPK) methods. To accomplish this, START is mounted to each 
aircraft prior to testing. At JBCC, up to four START systems were simultaneously deployed on different test 
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aircraft in order to minimize transition times between aircraft and optimize field measurement personnel 
time. During flight tests, satellite data were collected simultaneously, at both the Rover (UAS/aircraft-
under-test) and a Reference Position on the ground. For the purpose of these measurements, data from 
a Continually Operating Reference Station (CORS) at Falmouth, MA (MAFA) were used. MAFA is the 
nearest CORS to JBCC and is operated by the Massachusetts Department of Transportation (MASSDOT). 
 
START hardware consists of a u-blox NEO-M8T receiver which is integrated with a grounding plate and 
active, dual-feed, ceramic patch antenna. The system is controlled and configured using a miniature 
computer which runs u-blox u-center software. Data are stored at the computer on removable SDHC 
media. Power is provided by 5V, 2A, USB “power banks” of various capacities. The core components of 
the START Rover are presented, along with weights and dimensions, in Table 4. Figure 19 displays the 
START integrated receiver/antenna mounted on top of a DJI M600 test aircraft at JBCC. 
 
Table 4 - START System Components 

Function Component Weight 
(g) 

Length (mm) 
Comments 

X Y Z 

Receiver uBlox NEO-M8T High 
Gain: X-Series 80 100 100 25 with integrated 

antenna + ground plate 
*Rover Control 

Computer Intel Compute Stick 60 113 38 12  

Rover Battery 4400 mAH Power Bank 115 95 46 22 Option 1 
Rover Battery 5000 mAH Power Bank 124 98 47 22 Option 2 
Rover Battery 6000 mAH Power Bank 148 99 47 22 Option 3 

*USB interconnect cables not included 
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Figure 19 - START System Mounted on DJI M600 

3.3 Meteorological Data Collection Systems 

Each flight test day, the Volpe team set up a Vaisala WXT520 weather station to collect localized wind 
speed, temperature, and relative humidity data at a 2Hz resolution (twice per second) to contextualize 
the acoustics data. The weather sensor was elevated 14.5 feet above the ground, southeast of the 
microphone array center point, between the acoustics van and the flight path. A westerly view of the 
system setup is pictured in Figure 20.  
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Figure 20 – Volpe Temporary Weather Station Setup at JBCC (Westerly View) 

A pre-existing permanent Vaisala WXT520 weather station was simultaneously collecting 1Hz 
meteorological data in the vicinity of the flight test area. This sensor was elevated 15 feet above the 
ground, approximately 750 feet north of the microphone array.  

3.4 Meteorological Data Supplementary Comparison 

The 2Hz meteorological data captured with the temporary Volpe set up were averaged to 1Hz for direct 
assessment with the meteorological data captured at the pre-existing permanent weather station. A 
supplementary comparison between data measured at each location was conducted post-measurement 
to evaluate whether the data from the permanent weather station (distanced farther from the 
microphone array) are representative of the meteorological conditions at the flight test area. Agreement 
between data from both locations would allow future measurement teams to leverage the existing system 
for future flight test deployments at JBCC, rather than setting up and tearing down the temporary system 
closer to the microphone array each day.  
 
Data measured at both locations were synchronized and compared prior to analysis. Only one-second 
timestamps for which both systems collected reliable data for each meteorological metric were 
compared. Meteorological data were collected with the temporary weather station at different times of 
day and for different durations, depending on the flight test schedule. Data collected each day were 
separated into 3-hour bins for analysis in order to account for diurnal meteorological trends. The 
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“morning” bin represents data collected between 9:30:00-12:30:00 UTC. The “afternoon” bin represents 
data collected between 12:30:01-15:30:00 UTC. The “evening” bin represents data collected between 
15:30:01-18:30:00 UTC. The “night” bin represents data collected from 18:30:01 to the end of the flight 
test day (no later than 23:00:00 UTC). The following tables split up by day, display the average percent 
delta 1 for each of the three meteorological metrics. 2 
 

Table 5 – September 28th Met Station Comparison 

Temporal Bin Wind Speed 
Delta (kts) 

Temperature 
% Delta 

Relative 
Humidity   
% Delta 

Morning 0.30 -0.09 -4.95 
Afternoon 0.63 -0.44 -4.87 

 

Table 6 - September 29th Met Station Comparison 

Temporal Bin Wind Speed 
Delta (kts) 

Temperature   
% Delta  

Relative 
Humidity    
% Delta 

Afternoon 2.64 -0.95 -8.65 
Evening 2.05 0.15 -9.33 
Night 0.97 1.37 -8.06 

 

Table 7 - September 30th Met Station Comparison 

Temporal Bin Wind Speed 
Delta (kts) 

Temperature    
% Delta 

Relative 
Humidity          
% Delta 

Morning -0.04 -0.39 -4.26 

Afternoon 0.21 0.10 -6.41 

Evening 0.90 0.56 -9.47 

Night 1.18 0.78 -10.10 
 

Table 8 – October 1st Met Station Comparison 

 
1 Average Percent Delta = average of each one-second {[(Temporary - Permanent)/Permanent]*100} measurement 

within the temporal bin 
2 Wind speed data captured with the temporary weather station in units of meters per second were converted to 

knots to facilitate direct comparison with the permanent wind speed measurements. A 20-second rolling average 
of wind speed measurements from each system was then computed to minimize the effects of instantaneous wind 
gusts. Wind speed percent delta computations for each temporal bin were based on the 20-second rolling 
averages. 
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Temporal Bin Wind Speed 
Delta (kts) 

Temperature  
% Delta 

Relative 
Humidity         
% Delta 

Morning -0.11 0.32 -5.00 
Afternoon 0.52 -0.97 -7.35 

 
The above tables show that the average relative humidity percent delta is always negative, regardless of 
time of day or day of flight testing. Figure 21 illustrates that both locations closely track the same trends 
throughout the day, but the flight test area weather sensor recorded a lower relative humidity. This 
difference could potentially be explained by the landscaped flight test area, which would otherwise be 
covered in tall brush that can retain more moisture. The permanent system is set up outside of the 
landscaped zone, above the tall brush. The difference between the mowed flight test area and the tall 
brush is shown in Figure 20. It is also apparent that there are discrepancies between the wind speed data 
collected at both locations. This difference is likely due to the openness of the cleared flight test area; the 
temporary weather sensor is farther away from trees and other larger obstructions than the permanent 
weather system. Figure 22 depicts measured wind speed data for September 29th at both locations, in 
which the average wind speed deltas and percent deltas are the largest out of all the test days.  

It is reasonable to conclude that the data collected at the permanent weather station is not entirely 
representative of the meteorological conditions at the flight test area due to its distance from the 
measurement area. The team recommends that a temporary weather station continue to be set up within 
the flight test area for future flight test deployments at the AERF site until a more complete comparison 
validation can be completed. 

 
Figure 21  – September 29th Relative Humidity Measurements 
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Figure 22  – September 29th Wind Speed Measurements (20-Sec Rolling Average) 

  Data Description 

4.1 Pressure Time-History Acoustic Data 

The pressure time-history acoustic data were formatted into digital files following the ANSI/ASA S12.75 
standard. Data files comprise an ASCII header (lines 1-52) and binary pressure time-history acoustic data. 
The acoustic data file naming convention and header description are given in Sections 4.1.1 and 4.1.2, 
respectively. One-third octave band spectral time histories were generated from the acoustic pressure 
time history data files and are described in Section 4.2. For both types of data file, individual files 
correspond to a specific event and microphone location.  

4.1.1 Acoustic Data File Naming Convention 

An acoustic data file was created for each event/microphone combination. File names follow the 
convention: 
 
RUN[nnnn]_JBCC_[vehicle]_[test ID]_[mic ID]_102400HZ_CH[nnn].bin 
 
Where terms correspond to:  

• RUN[nnnn]  four-digit run number (e.g. 0081) 
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• JBCC  test location, Joint Base Cape Cod 
• [vehicle]  short name of vehicle model or noise source (e.g. M600) 
• [test ID]  test-point identifier (e.g. F05) 
• [mic ID]  microphone position identifier (e.g. F45W) 
• 102400HZ  sampling rate 
• CH[nnn]  data acquisition system channel number (e.g. ch008) 

 
An example acoustic data file name is RUN0081_JBCC_M600_F05_F45W_102400HZ_CH008.bin. Noise 
source abbreviations are as follows: 

• AMBI  ambient measurement 
• HORN  horn test 
• M600  DJI Matrice 600 
• TRNS  ALTI UAS Transition 
• M210  DJI M210 V2 RTK 
• FIRI  ArgenTech FireEye SERIES 2 
• PHM4  DJI Phantom 4 Pro 

4.1.2 Acoustic Data File Header Description 

The test conditions and contents of each acoustic file are described in the header lines which follow the 
ANSI/ASA S12.75 standard header format. This header includes metadata: measurement event details, 
acoustic recording channel information, microphone information and location. Header fields are 
described in Table 9; Figure 23 shows an acoustic file header with example entries for these 
measurements. 
 
Table 9 - Metadata Table Fields 

Data Field Name Description 
Header Size Number of ASCII header lines before binary data 
Test Description VOLPE JBCC UAS MEASUREMENTS 
Test Location Description of geographic location where measurements were made  
Run Number Numerical identifier for a specific measured event  
Date Measurement date in DD MMM YYYY format 
Start Time (UTC SPM) Time at beginning of file in seconds past midnight, universal 

coordinated time format 
Vehicle Make Model Make and model of the unmanned aerial vehicle 
Test ID Test point identifier from test cards 
Direction of Travel (Nominal) Nominal direction of aircraft travel  
Weight Aircraft test-point weight, and nominal weight 
Speed Aircraft test-point speed, and nominal weight  
Condition Flight condition 
Altitude Aircraft test-point altitude, and nominal altitude 
Sample Rate (Hz) Acoustic data sampling rate in Hertz 
Samples Total Total number of data points in the binary portion of file 
Data Format Format of numerical data in binary portion of file 
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Machine Format Sequence of bytes in the digital data 
Units Units of the numerical data in binary portion of file 
Temperature (deg F) Event-average air temperature in degrees Fahrenheit 
Humidity (Percent) Event-average relative humidity percentage 
Wind AVG SPD (Knots) Event-average wind speed in knots 
Wind MAX SPD (Knots) Maximum wind speed measured during event in knots 
Wind SPD STD (Knots) Standard deviation of wind speed during event in knots 
Wind DIR (Deg) Event-average wind direction in degrees 
Ambient Noise Notes Notes from acoustic log and observer log about ambient noise 
Run Notes Notes from acoustic log about the run 
Channel Number Acoustic data recording node channel number 
Channel Description Description of physical location of microphone 
Channel ID Alphanumeric microphone location identifier 
Mic Latitude (deg) Latitude of microphone location in decimal degrees 
Mic Longitude (deg) Longitude of microphone location in decimal degrees 
Mic X (M, Local) x-location of microphone in local coordinate system 
Mic Y (M, Local) y-location of microphone in local coordinate system 
Mic Z (M, Local) z-location of microphone in local coordinate system 
Ground Elevation (M) Elevation of local ground above datum 
Datum Geodetic datum system 
Transducer Make Model Transducer (microphone) make and model 
Transducer SN Transducer (microphone) manufacturer serial number 
Transducer Sound Field Type of pressure field microphone was designed to measure 
Meas Sensitivity (mV/Pa) Test-day measured microphone sensitivity in mV/Pa 
Preamp Make Model Microphone preamplifier make and model 
Preamp SN Microphone preamplifier manufacturer serial number 
Amplifier Make Model Signal conditioning amplifier make and model 
Amplifier SN Signal conditioning amplifier manufacturer serial number 
Transducer Supply Power supply type for the transducer (microphone) 
Orientation Microphone orientation 
Windscreen Make Model Windscreen type, make, and model 
DAQ Make Model Acoustic data acquisition device make and model 
DAQ SN Acoustic data acquisition device manufacturer serial number 
DAQ Device Number Acoustic data acquisition device input path description 
DAQ Coupling Acoustic data acquisition system input coupling 
Channel Notes Notes specific to acoustic measurement channel 
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Figure 23 - Example acoustic data file header block 

4.2 1/3 Octave-Band, Half-Second Time-History Data 
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Pressure time-history acoustic data were processed in one-third octave band spectra time histories at 
0.5 second increments. To do so, ANSI-compliant methods from the NI Sound and Vibration toolkit were 
used as part of an in-house tool. One-third octave band files were created in the SuperFAR format (Read 
et al., 2017). File format is comma-separated ASCII text with one file per microphone per event. File 
naming convention follows that of the acoustic data files described in Section 4.1.1. The spectra represent 
slow exponentially time averaged levels with flat frequency weighting. Note that each timestamp 
corresponds to the instant 0.75 seconds prior to the output of the most recent sample within the average, 
as described in ICAO Annex 16. An example file with header is shown in Figure 23. Note that levels are 
given in decibels re: 20 μPa for one-third octave bands with center frequencies from 6.3 Hz to 20 kHz. 
 

 
Figure 24 - Example one-third octave band time history file 

4.3 Tracking System Data Summary 

GNSS signals, as received on Earth, have inherent errors, such as satellite clock drift and atmospheric 
delays, which adversely affect positional accuracy and precision. However, when GNSS observables are 
collected simultaneously at a reference position and a point, or points of interest (Rover), then the data 
from the Reference Position may be used to enhance the precision of the Rover data using post-process 
kinematic (PPK) corrections. This is accomplished by comparing carrier phase measurement differences 
between the “known” location of the reference antenna and the Rover position, e.g., a microphone 
location or aircraft trajectory. In this manner, the accuracy of the Rover position may be improved to 
centimeter-level, relative to the Reference Position and other points that have been surveyed, such as the 
microphone positions.  
 
For the JBCC flight tests, START hardware was configured to collect GNSS observables at 10 Hz. These raw 
data were saved to a proprietary u-blox format (.ubx). For post-processing, however, data must first be 
converted to the Receiver Independent Exchange Format (RINEX). RINEX is a standard which defines GNSS 
data formats so that they may be compatible with processing tools. Once converted to RINEX, RTKLIB 
software was used to apply PPK corrections. RTKLIB is an open source suite of software tools that is widely 
used in academia, industry and government. RTKLIB Demo5, used to process the JBCC data set, is a branch 
of RTKLIB optimized for practical applications and use with lower cost receivers, such as those produced 
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by u-blox.  
 
The RTKPOST software tool produces the PPK output in the form of ASCII text files (.pos) which contain 
the timing, positioning and velocity data of interest. Specifically, the .pos files include the data time stamp, 
latitude/longitude (ITRF2014), height (WGS84 ellipsoid), quality flags (indicating solution type), # of 
satellites used in solution, velocities (N, E, U), and several other parameters that may be used to asses 
solution quality. An example the PPK output file is shown below in Figure 25. 
 
The PPK output files were processed further using a code written in R, originally developed by the Volpe 
team to process tracking data from previous measurement campaigns where the START system was 
deployed. This additional post-process uses the PPK output file data, along with surveyed reference 
position data to calculate position in a local coordinate system (where [0, 0, 0] is the centerline 
microphone position), and the nominal flight track is oriented parallel to the Y-axis. The R program also 
calculates additional aircraft kinematic metrics such as ground speed, emission angle, and slant range for 
each position record. The PPK data converted to the local coordinate system along with aircraft ground 
speed is used as input data for the noise hemisphere creation process. 
 

 
Figure 25 - Example of PPK Output File Format 

4.3.1 VerifyRINEX 

VerifyRINEX is a console application developed by Volpe and intended to quickly assess the completeness 
and integrity of RINEX files derived from START data. Due to their compact nature and often high levels of 
radio frequency interference (RFI) from internal transmitters, small UA can be a challenging environment 
for low level GNSS signals. To monitor and mitigate missing or incomplete START Rover data, data contents 
were checked for completeness, both during and after each vehicle flight test. A log of all missing data 
points, per day, per aircraft/file can be found in Appendix C. Only files with at least one data dropout are 
listed. Note that gaps are listed for any data dropout, whether occurring during flight events or inactive 
periods. 
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4.4 Log Sheets and Metadata Tables 

Daily acoustic log sheets were maintained to track all flight event times. Anomalous ambient noise 
contamination and trajectories that deviated significantly from the nominal flight path based on visual 
inspection were also documented in the logs. Table 10 describes all data recorded on the field logs.  
 
Table 10 - Acoustic log sheet data fields 

Data Field Name Description 
Date mm/dd/yyyy 
Acoustics System CARS 1 & 2 or ancillary LD 831 sound level meters 
Site Name JBCC 
Aircraft Model name 
Site ID Linear or Hover array 
Personnel Last name of team member filling out field log (Kaye) 
Test Director Initials of Test Director (CCW) 
Acoustics Lead Initials of Acoustics Lead (RD) 
Tracking Lead Initials of Tracking Lead (RS) 
Facilities Director Initials of Facilities Director (CS) 
Event ID From flight card (e.g., F01, V02, H04) 
Event Description Aircraft condition (e.g., level flyover, hover, takeoff, landing) 
Direction of Flight Initial of cardinal direction with vertical indicator, if applicable (e.g., N, S, up S, 

N down)  
Data On Time hh:mm:ss (UTC) of signal to initiate acoustic recording before event 
Time @ OH hh:mm:ss (UTC) of when aircraft flew over array center point  
Data off Time hh:mm:ss (UTC) of signal to end acoustic recording after event 
Comments Notes on ambient noise contaminations during event or anomalous 

trajectories, if applicable (e.g., distant roadway noise at end, windy 
throughout, very southerly hover) 

 
Daily site diagrams were also drawn depicting the microphone array configurations and flight paths 
implemented that day, along with key locations of personnel and other landmarks. 
 
Supporting information for the JBCC measurement is summarized in the metadata file named 
2021_JBCC_UA_Measurement-Volpe_METADATA.xlsx. The excel spreadsheet includes the four sheets 
described below. Note that much of the metadata information was also included in header lines in the 
acoustic data files. 
 

1. RUN METADATA summarizes test conditions for each event;  
2. CH METADATA summarizes acoustic measurement channel attributes; 
3. CH MEASURED SENSITIVITY provides a table of the daily measured sensitivities for each channel; 

and  
4. ELECTROSTATIC ACTUATOR RESPONSE provides a table of electrostatic actuator response data for 

each microphone used in the JBCC measurements 
 

Start time and end time in the run metadata table correspond to earliest microphone file starting time 
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and the latest microphone file end time. For many runs, the file start and end times are the same for all 
microphones. For other runs, it was not always possible to trim files to common start/end times without 
removing useful data and as such the start/end times for channels 1–8 may be slightly different from 
channels 9–16, as indicated by header fields START TIME and SAMPLES TOTAL in each file. 
 
Log sheets for the tracking system (START) were also populated during the flight tests. START logs are 
used to identify system components deployed on each aircraft and to correlate tracking file names with 
takeoff and landing event times to aid in post-processing corrections to tracking data.  

4.5 Database Design and Implementation 

Data collected at JBCC were curated to be stored in a relational database. The primary function of the 
database is to facilitate access to data by creating an index of events that correlates data recorded in 
separate systems by date, time, and location of measurement site. The database was designed with a 
generic format that is intended to be suitable for housing data collected in future unconventional aircraft 
measurement campaigns. The database contains time-history of sound level data at several frequency 
weightings and across the 1/3 octave band, as well as meteorological data, session logs, flight logs, 
meteorological data, tracking data, and some instrument settings. The database does not contain raw 
pressure time-history data but does contain a reference and link to the location of raw audio files 
associated with each event. 
 
The database is composed of data sourced from the Acoustic Data Collection System, the “START” 
Tracking System, and the Meteorological Data Collection System. A Python script is used to convert the 
source data that have been output from each system into an indexed file structure that can be readily 
imported into a relational database by way of Structured Query Language (SQL). During the format 
conversion, the user is prompted to provide the list of aircraft for which data were collected, as well as 
the name of the acoustic measurement device and date of measurement associated with each event file 
extracted from the sound level meter. These inputs are used to create an index for each event in the 
relational database. The SQL script used to create the database requires the user to provide 2 inputs: 
 

1. A path to the data files that have been pre-processed, in Python, into an indexed file structure. 
2. A list of the files containing tracking data, separated and named by aircraft and date  

 
A list of the database tables is detailed in Table 11. Table data are sourced from output files from the 
acoustic measurement device, START system output files, digitized log files, or are derived from one or 
more of those systems. A complete data dictionary, detailing fields from each table, can be found in 
Appendix D. 
 
Table 11 - Database Tables & Descriptions 

Table Name Description Source 
Master_List List of Unique Events - [Index] field is Primary Key SLM 
Aircraft List of Aircraft - [Aircraft_ID] field is Primary Key Derived 

Calibration_History 1/3 Octave Band Time History of Calibration Records - [Index] is 
Foreign Key 

SLM 
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Overall_Settings Sound Level Meter Settings - [Index] is Foreign Key SLM 
Log_Sheet Digitized log sheets Log 
Session_Log Session logs from Sound Level Meter - [Index] is Foreign Key SLM 

Time_History Time History of Sound Level Records at LASeq, LASmax, LZSeq, and 
1/3 Octave Band Frequencies - [Index] is Foreign Key SLM 

Time_History_Key Time History Record of Keys indicating status change of Sound 
Level Meter During Events - [Index] is Foreign Key Derived 

Weather Meteorological Data - [Index] is Foreign Key SLM 
Weather_Expanded Expanded Meteorological Data - [Index] is Foreign Key SLM 

Tracking dGPS data from the START Tracking System - [Aircraft_ID] is 
Foreign Key START 

  
The entity relationship diagram in Figure 26 depicts the eleven database tables and any primary or foreign 
key relationships between tables. The key icon indicates a primary key relationship and points to the 
parent table, which holds the primary key field. The Master List table serves as a primary key and central 
point of reference when querying or manipulating event data sourced from the Acoustic Data Collection 
System. Data from logs and START tracking system can be correlated to each event by date, time, and 
aircraft. 
 

 
Figure 26 - Database Entity Relationship Diagram 
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 Preliminary Noise Level Summary 
The maximum overall slow time-averaged, A-weighted sound levels (LASmax) were identified and extracted 
at three specific microphone locations (F000, F45W, and F90E) for all “F01” (max weight, max speed, low 
flyover altitude) flight events flown over the course of the measurement campaign by four UA platforms. 
Time synchronized slant range (straight line distance from the aircraft to the microphone of interest) 
values at the time of LASmax were calculated and extracted for each event and microphone position. The 
LASmax values were then normalized to a slant range of 400 ft. to facilitate basic comparison between 
aircraft noise levels. Tables 12 through 15 present arithmetic averages of Slant Range, LASmax, and 
normalized LASmax for all F01 flight events, broken down by aircraft and microphone position. The total 
number of F01 flight events for each aircraft is listed in each table. Note that the process used for 
normalization of LASmax level to a reference slant range of 400 ft. only includes a distance-dependent 
adjustment for spherical spreading, using Equation 1. This preliminary data summary suggests potential 
directivity differences between the three microphone positions, as the averaged, normalized, LASmax 
values do not converge as one might expect with an omnidirectional acoustic source. It is also possible 
that the LASmax occurred at slightly different times at each microphone position, thereby affecting the slant 
range and subsequent normalization. Further investigation is needed to confirm the factors contributing 
to this discrepancy. 

 

𝐿𝐿𝐿𝐿𝐿𝐿𝑚𝑚𝑚𝑚𝑚𝑚(400 𝑓𝑓𝑓𝑓.𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛) = 20 ∗ log(
𝑆𝑆𝑆𝑆 @ 𝐿𝐿𝐿𝐿𝐿𝐿𝑚𝑚𝑚𝑚𝑚𝑚

400 ) 
Equation 1 - LASmax Normalization to 400 ft. (Spherical Spreading Adjustment) 

 
Table 12 - LASmax Summary table for DJI M600 

DJI M600 
Total Number of “F01” Flight Events 12 

Mic Location Slant Range 
@ LASmax (ft) 

LASmax (dBA) LASmax normalized to 
400 ft. (dBA) 

F000 56.69 73.8 56.8 
F45W 111.25 63.9 52.8 
F90E 127.86 59.2 49.3 

 

Table 13 - LASmax Summary table for DJI M210 

DJI M210 
Total Number of “F01” Flight Events 6 

Mic Location 
Slant Range 
@ LASmax (ft) LASmax (dBA) 

LASmax normalized to 
400 ft. (dBA) 

F000 85.15 67.7 54.2 
F45W 76.23 67.5 53.1 
F90E 169.05 54.5 47.0 
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Table 14 - LASmax Summary table for ArgenTech FireEye Series 2 

ArgenTech FireEye Series 2 
Total Number of “F01” Flight Events 12 

Mic Location 
Slant Range 
@ LASmax (ft) LASmax (dBA) 

LASmax normalized to 
400 ft. (dBA) 

F000 432.11 69.6 70.3 
F45W 449.71 69.4 70.4 
F90E 354.88 66.0 64.9 

 

Table 15 - LASmax Summary table for DJI Phantom 4 Pro 

DJI Phantom 4 Pro 
Total Number of “F01” Flight Events 6 

Mic Location Slant Range 
@ LASmax (ft) 

LASmax (dBA) LASmax normalized to 
400 ft. (dBA) 

F000 42.52 70.0 50.5 
F45W 103.98 56.8 45.1 
F90E 124.08 54.4 44.2 
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  Conclusions and Next Steps 

6.1 General Observations 

Overall, many of the efficiencies anticipated by using the AWRF site at Joint Base Cape Cod were realized 
during the course of the measurement campaign. Of particular importance to the uninterrupted operation 
of the aircraft was access to electrical power out in the field, which eliminated the need for pilots and 
aircraft to return to the AWRF building for battery swaps and charging. This was a huge time saving 
mechanism and allowed the team to pivot from one aircraft to another with minimal interruption. 
Coordination with other JBCC base operations was also key to a successful campaign, especially when 
there were other nearby military and coast guard operations (both aircraft and ground vehicles).  
 
As expected (and as is the case for any measurement campaign) the weather proved to be the largest 
source of day-to-day uncertainty. It was necessary to keep a close eye on available weather and wind 
forecasts each day, and for the Test Director to make a “go / no-go” decision each evening prior to the 
next measurement day. The AWRF site may present marginally higher risks of wind speeds above 
acceptable flight and measurement limits, but not enough so to avoid the site altogether for future 
campaigns, particularly in light of the significant efficiency and cost savings associated with the site.. 
 
Despite rigorous pre-planning and coordination with the UA pilots and fleet managers, it became apparent 
that the specifics of the required flight operations had not been communicated clearly enough, and time 
was spent fine tuning flight programs in the field. Although the team is asking for relatively “simple” flight 
operations (straight-line, one altitude), some operators may not have experience “stacking” these flights 
for repeatable test events. The Volpe team recommends that any prospective UA operators be required 
to fly test flight events (based on the measurement flight cards) prior to the measurement campaign to 
ensure there are no major issues or questions once the aircraft are onsite. This will also aid the team by 
discovering any differences between the manufacturers quoted flight specifications and the real-world 
performance of the aircraft. It will also highlight any particular safety concerns that might be able to be 
worked through prior to the measurement deployment. 
 
During the measurement campaign, the START system experienced loss of satellite signal for varying 
lengths of time between a few seconds and a few minutes. These dropouts occurred on one particular 
aircraft, regardless of time of day, flight event, or system components. The Volpe team suspected this 
aircraft emits a substantial amount of RF energy from the internal aircraft system, motors, and batteries, 
which had a significant impact on START system performance. This suspicion was confirmed with the use 
of an RF “sniffer” that indicated high levels of potentially contaminating energy emanating from large 
sections of the aircraft. Unfortunately, there were few other mounting options for the START system, 
particularly for the receiver module, and so the dropouts were difficult to avoid during flight tests for this 
aircraft. In the future, the RF sniffer will be used to determine ideal and/or suboptimal mounting positions 
for the START system components. The Volpe team may also fabricate or procure shielding components 
to protect the START system components from RF interference when mounted on aircraft. 
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Anecdotally, the most interesting flight condition for all of the aircraft measured (in terms of loudness and 
acoustic “harshness”) seemed to be the transition states between hover and forward flight. This was 
especially apparent for the fixed-wing, hybrid aircraft, which matches the anecdotal experience from 
previous measurement campaigns. Additionally, there seems to be noticeable directivity in the noise from 
all of the aircraft, both on the ground and at/above the rotor plane. 
 
In comparison to traditional aircraft, the noise generated by the aircraft measured in this campaign was 
often extremely variable and often heavily influenced by the aircrafts’ use of rotor speed to maintain a 
constant ground speed against small changes in wind. These fluctuations will likely not be captured by 
acoustic metrics that average energy over a large time period. 

6.2 Next Steps and Recommendations 

Further analysis of the acoustics and tracking will be needed to make substantial conclusions about the 
anecdotal points raised in Section 6.1 such as transition state noise, directivity, and short time varying 
characteristics. The Volpe team continues to work with FAA to perform such analyses and use the 
conclusions to inform future policy and measurement recommendations. 
 
Of particular interest will be the noise hemisphere creation process using the data gathered by the 
larger microphone array, which will be applied to environmental analyses of particular UA operations in 
the community, as well as highlight any particular directivity inherent to these aircraft. 
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 Appendix A: Acoustic Instrumentation 

8.1 Signal Path Table and Diagram 

Table 16 - Volpe CARS Signal Path Details 

Signal 
path 

number 

Mic Array 
Position(s) 

Cable 
length 

(ft) 

Gain 
amp 

number 

Gain 
amp 

channel 

NI node 
number 

NI channel B&K 2671 
s/n 

G.R.A.S. 
40AO s/n 

Mic 
sensitivity 

(mV/Pa) 

B&K 2693 
s/n 

cRIO 9037 
s/n 

AI module 
model 

AI module 
s/n 

Master 
Clock GPS 
200A s/n 

1 F30E/H045 150 1 1 1 /dev3/ai0 2048356 450121 10.71 3009990 01B0DE4F NI-9250 1E4AF4B n/a 

2 F20E/H090 200 1 2 1 /dev3/ai1 2263944 427509 9.82 3009990 01B0DE4F NI-9250 1E4AF4B n/a 

3 F10E/H135 200 1 3 1 /dev4/ai0 2048357 427457 9.26 3009990 01B0DE4F NI-9232 1BC67DC n/a 

4 F000 200 1 4 1 /dev4/ai1 2048207 427455 12.14 3009990 01B0DE4F NI-9232 1BC67DC n/a 

5 F10W 250 2 1 1 /dev4/ai2 2048159 407580 9.67 3009994 01B0DE4F NI-9232 1BC67DC n/a 

6 F20W 250 2 2 1 /dev5/ai0 2263947 450114 12.97 3009994 01B0DE4F NI-9232 1BFA316 n/a 

7 F30W 300 2 3 1 /dev5/ai1 2263949 407565 10.13 3009994 01B0DE4F NI-9232 1BFA316 n/a 

8 F45W 350 2 4 1 /dev5/ai2 2048208 450231 10.17 3009994 01B0DE4F NI-9232 1BFA316 n/a 

9 F50E 150 3 1 2 /dev3/ai0 2263953 427458 11.19 3009989 01B0DE4E NI-9250 1E4AF4F n/a 

10 F60E 200 3 2 2 /dev3/ai1 2048206 450150 11.66 3009989 01B0DE4E NI-9250 1E4AF4F n/a 

11 F70E 200 3 3 2 /dev4/ai0 2048158 315753 13.01 3009989 01B0DE4E NI-9232 1BDA52C n/a 

12 F80E 250 3 4 2 /dev4/ai1 2048157 315754 12.71 3009989 01B0DE4E NI-9232 1BDA52C n/a 

13 F90E 250 4 1 2 /dev4/ai2 2048032 315766 12.11 3009988 01B0DE4E NI-9232 1BDA52C n/a 

14 H225 250 4 2 2 /dev5/ai0 2125164 315801 11.22 3009988 01B0DE4E NI-9232 1BC67DD n/a 

15 H270 200 4 3 2 /dev5/ai1 2263946 264031 11.35 3009988 01B0DE4E NI-9232 1BC67DD n/a 

16 H315 200 4 4 2 /dev5/ai2 2125166 282648 9.76 3009988 01B0DE4E NI-9232 1BC67DD n/a 

17 Time code 
 

n/a n/a 1 /dev6/ai0 n/a n/a n/a n/a 01B0DE4F NI-9232 1BC67D8 8337010 

18 Time code 
 

n/a n/a 2 /dev6/ai0 n/a n/a n/a n/a 01B0DE4E NI-9232 1BC67E0 8273096 
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Figure 27 - Volpe CARS Diagram
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8.2 Acoustics System Setup Documentation and Field User Guide 

1. General equipment setup  
a. Ground plate setup 

i. Place and center ground plate on relatively flat, level terrain at predetermined, 
surveyed, location. 

ii. Use local soil or potting soil to provide flat, level mounting surface for ground 
plate: remove excess vegetation, rocks, etc. from plate location, place soil in area 
and temporarily install and remove the plate to identify and fill-in any voids; 
compress the soil under the plate to form stable solid surface; nestle the ground 
plate into the soil, making sure that all air pockets are eliminated and the edges 
of the plate are flush with the ground. If necessary, trim local grass, etc. within 
several inches of the edge of the plate. The goal is to integrate the plate into the 
local surface as smoothly as possible, and to minimize abrupt transition between 
acoustical surfaces. 

b. Ground plane microphone setup 
i. Screw (3) spider legs into mic preamplifier collar assembly. 
ii. Attach microphone to preamplifier – back preamplifier through spider collar 

before connecting cable.  
iii. Attach 150’ – 350’ BNC microphone cable to preamplifier, and suspend cable 

above plate using cable support inserted into ground adjacent to plate. 
iv. Route BNC mic cable to instrument table and connect to B&K Nexus signal 

conditioning amplifier input. 

 
Figure 28 - Ground plate & Mic Setup 
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2. Instrument table setup 

a. Timecode generator 
i. Connect GPS antenna to antenna input at rear of MasterClock GPS-200A.  
ii. Position the antenna to allow for best possible exposure to the sky, away from 

other instrumentation.  
iii. Connect ring lugs of DC power cable to 12V battery. 
iv. Connect the RS232-to-BNC adapter to the RS-232 output (rear) of the GPS-200A; 

connect a BNC cable to recording node on channel 9 (module 6, analog input 0). 
v. Turn on GPS-200A time code generator by inserting DC power cable to DC input 

jack at rear of GPS-200A. A solid green light indicates power. 
 

 
Figure 29 - MasterClock setup steps i-v 

b. B&K Nexus signal conditioning amplifiers 
i. Connect B&K DC power cables to 12V batteries via cigarette-lighter-style 

connectors. 
ii. Power on amplifiers before connecting microphones. Note: if microphones 

are connected to amplifier when it is powered on, the amplifier will read 
the TEDS from the preamplifier and will apply the transducer sensitivity in 
the amplifier. Sensitivity will be applied in software by the recording node 
instead. 

iii. Connect microphone preamplifiers to signal conditioning amplifier inputs 
using BNC cables. 
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Figure 30 - Nexus signal conditioning amplifier setup – steps i-ii 

3. cRIO recording node hardware setup 
a. Connect GPS antenna to antenna input on 9467 module (module 7). 
b. Use USB cable to connect solid state drive (module slot 2) to upper USB input on left side 

of recording node front panel. 
c. Use BNC cables to connect signal conditioning amplifier outputs for microphones 1-8 to 

input modules 3-6 as follows. Note that analog input numbers are printed on each module 
near the upper left quadrant of BNC terminals. 

i. Channel 1  module 3, input 0  
ii. Channel 2  module 3, input 1 
iii. Channel 3  module 4, input 0 
iv. Channel 4  module 4, input 1 
v. Channel 5  module 4, input 2 
vi. Channel 6  module 5, input 0 
vii. Channel 7  module 5, input 1 
viii. Channel 8  module 5, input 2 

d. Use BNC cable to connect signal from GPS-200A to module 6, input 0. 
e. Connect ethernet cable to ethernet port 1 on recording node (labeled “10/100/1000”) 

and connect other end to network hub port 2 or 3.  
f. Use quick-disconnect power cable to connect recording node power to a pair of sealed 

lead-acid batteries wired in series for 24V power.  If quick-disconnect power cable is not 
already connected to recording node, connect bare wires to black screw terminal 
(V1positive terminal of power source, Cnegative terminal of power source).  

g. Note: cRIO will boot automatically when power is connected. During the boot-up 
sequence, the 4-LED panel in the upper left corner of cRIO chassis will show a green LED 
and a yellow LED in positions 1 and 2 respectively. When cRIO operating system is running, 
the second LED will turn off.  
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Figure 31 - cRIO recording node setup – steps a-f 

 
Figure 32 - cRIO recording node batteries and quick disconnect power cable 

h. Network hub: 
i. The two cRIO recording nodes and field laptop will be connected over a local 

network through a hub. Connect a power inverter to terminals of a 12V battery. 
ii. Connect the AC-DC power converter to the power outlet on the inverter and 

connect the DC power to the network hub. 
iii. Use an ethernet cable to connect the ethernet port on the back of the field laptop 

to port 1 on the hub. 
 



 
         JBCC UA Noise Measurement Report    60 

 
Figure 33 - Network hub powered through inverter setup – steps i-ii 

 
Figure 34 - Cabling diagram for acoustic signals 
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Figure 35 - Cabling diagram for power and non-acoustic signals 

4. Instrument setup 
a. B&K Nexus signal conditioning amplifiers 

i. Amplifier Setup screen: set filtering to 0.1 Hz to 100 kHz, and set sensitivity 
according to desired gain: 

Amplifier sensitivity Total gain in amplifier 

100 mV/Pa −20 dB 

316 mV/Pa −10 dB 

1.00 V/Pa 0 dB 

3.16 V/Pa 10 dB 

10.0 V/Pa 20 dB 

31.6 V/Pa 30 dB 

100 V/Pa 40 dB 

316 V/Pa 50 dB 

1.00 kV/Pa 60 dB 

3.16 kV/Pa 70 dB 

10.0 kV/Pa 80 dB 
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Specific gains are subject to change based on measured aircraft noise; initial gain 
settings for JBCC configuration will be 30 dB on NI-9250 channels and 40 dB on 
NI-9232 channels. If gain level(s) are to be changed in amplifiers, corresponding 
change must be made in recording node setup.  

ii. Transducer setup screen: select DeltaTron power supply (triangle symbol) and 
sensitivity units V/Pa. 

iii. Transducer supply screen: select 4 mA supply current and set cable length 
according to installed microphone cables (note: Nexus firmware assumes cable 
capacitance of 60 pF/m so an adjustment factor of 83.3/60 for RG-58 cable is 
included in cable length settings below): 

1. 150 ft   set cable length 64 m 
2. 200 ft   set cable length 84 m 
3. 250 ft   set cable length 104 m 
4. 300 ft   set cable length 128 m 
5. 350 ft   set cable length 148 m 

 
b. cRIO recording node software: Virtual Sound Level Meter (VSLM) 

i. In the VSLM front panel under system setup tab:  
1. Enter input file location from previous step. 
2. In the “Controller parameters” box on the right, ensure input 

configuration is set to “DC coupled” and “AC couple IRIG-B” is not 
selected. 

3. Set “load sensitivities” switch to desired position; initial microphone 
sensitivities can be taken from input file or from memory (last calibrated 
values). 

4. Run program by clicking the arrow in the upper left-hand corner , and 
check that “Input file status” reads “Input file found and loaded”. 

5. Check that correct number of channels are shown under “selected 
channels” and that gain values are correct. 
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Figure 36 - VSLM system setup tab 

ii. When the VSLM program is running, one can select different operating modes 
using the row of buttons along the top of the front panel and can view different 
data displays by selecting tabs such as “system setup”. This is illustrated in Figure 
37.  
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Figure 37 - VSLM basic controls 

iii. In the VSLM front panel under sound levels tab (Figure 38) check that: 
1.  all channels are present and updating at 0.5-second intervals. 

 

Figure 38 - VSLM Sound Levels tab 
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iv. Set recording time to 10 seconds, and press “Timed Record”. Verify that: 
1. Operating mode indicator changes to “Time record” (Figure 39) 

 

Figure 39 - VSLM in recording mode 

2. Files are recorded in the correct location (the location is shown on the 
Diagnostics tab) 

3. Files are of the correct number and size (7 binary files of around 4 MB 
each for 10 seconds at 102.4 kHz, 1 plain text file) 

v. Select “Time synch” operating mode, and select “Time synch” tab. A GPS survey 
will take approximately 10-15 minutes, after which the UTC / GPS time displays 
will begin actively updating. Once that is true, 

1. Set selector switch to UTC. 
2. Press button to synchronize system time with selected source. 
3. Verify that time synch succeeded by reading the last entry in the time 

synch log on the right. 
4. Verify time with wristwatch pre-set to UTC (approximate match to check 

UTC vs GPS time). 
vi. Press “Live View” mode and select sound levels tab. 
vii. Before recording acoustic data for analysis, confirm that GPS-200A has received 

sufficient information from satellites. The GPS-200A front LED should be blinking 
once per second. Blinking twice per second indicates that GPS-200A lost satellite 
signals but is generating timecode signal in freewheeling mode.  

viii. IRIG-B channels should report levels around 120 dB when a 50 mV/Pa sensitivity 
is applied3. A typical one-third octave band spectrum for an amplitude-modulated 
IRIG-B signal is shown in Figure 40; the 1 kHz carrier wave is evident. 

 
3 The concept of sensitivity as applied to an IRIG-B signal is not physically meaningful as the time code generator 
does not measure pressure. However, treating those signals in the same manner as acoustic data by calculating 
levels and spectra provides a convenient way to verify signal integrity. 
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Figure 40 - IRIG-B one-third octave band spectrum 

ix. The IRIG-B signal can also be visually inspected in the “Mic Signals” tab, after 
selecting diagnostic view operating mode and setting the channel selector to the 
IRIG-B channel. A typical IRIG-B signal is shown in Figure 41. 

 

Figure 41 - IRIG-B signal 

x. Repeat steps ii-xv for the second cRIO recording node. 
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5. Calibration 

a. Virtual Sound Level Meter calibration(s) 
i. Select “Calibrate mode”. 
ii. Use “Channel Selector” to select mic to be calibrated and apply calibrator to 

microphone.  
iii. Select the “Third octave band” tab (Figure 42) to verify that spectrum appears as 

expected with peak at correct frequency. 

 

Figure 42 - VSLM one-third octave band tab 

iv. Select the “Calibration” tab and enter calibration level from label (typically 94.1 
dB or 114.1 dB) into LabVIEW calibration tab under “Nominal Calibration Signal 
(dB)”. When signal is steady as indicated by needle gauge / indicator light and 
“Measured sensitivity” value has stabilized, click “Replace value in memory” 
button to replace value in memory. After that, record the calibration signal by 
pressing the “Record Cal signal” button. Verify that the software goes into 
“Record 1ch” operating mode. 

v. Repeat for additional microphones, making sure to change the microphone 
selected in the dropdown menu at the top left. Alternatively, conduct 
microphone simulator test using instructions from next section. 

vi. When calibration is complete, click “write cal log to file” button to write 
calibration log, and then select live view operating mode. 

b. Post-calibration 
i. Verify that files were written and are of the appropriate size by checking the 

directory contents in the terminal window.  
1. Calibration files will have names of the form: 
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[file descriptor]_[YYYYMMDD]_[HHMMSS]_cal_mic[NN]_102400Hz.bin 
2. At 102.4 kHz, calibration files for each channel should be approximately 

4 MB in size. 
 
 

c. Final ground mic setup 
i. Slide narrow portion of spacer bar between ground plate and microphone until 

the microphone touches the top of the spacer bar. Tighten the plastic set screw 
to lock the mic/preamplifier into place. 

ii. Place microphone into top of hemispherical windscreen and position so that the 
diaphragm is ¾ distance from the center of the plate to the trailing edge of the 
plate.  

 
6. Recording data and logging on cRIO nodes 

a. Two recording modes are available: “Timed record” and “Record until stop”. These modes 
are initiated by pressing corresponding buttons in the upper right corner of the VSLM 
window. These recording modes are functionally equivalent except that “Timed Record” 
stops recording after a user-specified number of seconds.  

b. To initiate recording, press “Record until stop” or enter the desired recording time and 
press “Timed record”. Verify that software goes into a recording operating mode and that 
“Error opening file” indicator did not change to red. 

c. Recording from either mode can be stopped at any time by pressing the “Stop recording” 
button. 

d. To electronically mark events, the user has two options: 
i. To write a text comment to the user log, type text in the box in the lower left part 

of the “Sound Levels” tab and press the “Write timestamped comment to log file” 
button (Figure 43). 

ii. To write an event number to the user log, press the “write timestamped event 
marker to log file” button in the lower left part of the “Sound Levels” tab. This 
also adds a marker to the diagnostics channel which can be correlated with 
acoustics channels during post processing. 

 

Figure 43 - Logging a comment in the VSLM Sound Levels tab 
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7. Audio sampling of data on cRIO nodes 
a. The cRIO recording nodes do not output analog audio that can be listened to through 

headphones or speakers. To listen to recorded signals, a separate program is available 

called AudioSamplecRIO. That program can be started by clicking the  icon on the 
taskbar. 

b. AudioSamplecRIO reads data from the last “Timed record” operation. To listen to channel 
audio, one must first record data using the “Timed record” mode. 

c. After recording is complete and software is back in the “Live view” operating mode, 
specify in the AudioSamplecRIO window (Figure 44): 

i. channels to be converted to audio data, 
ii. desired output level of the audio file (select a value high enough that the signal is 

not clipped), 
iii. The sampling rate (102.4 kHz). 

d. Run the AudioSamplecRIO program by clicking the arrow icon in the upper-left corner. 
The program may take a short amount of time to copy files from the recording node(s) to 
the laptop computer and convert files. It may be necessary to press the play button in the 
right side sub-window if sound does not begin playing through the field laptop following 
conversion.  

e. Audio will play sequentially: if 10 seconds of data were recorded one will hear 10 seconds 
of audio from the first channel followed by 10 seconds of audio from the second channel, 
etc. 
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Figure 44 - AudioSamplecRIO window for listening to recorded acoustic data 

 
8. Shutting down cRIO recording nodes 

a. When one is finished using cRIO recording nodes they should be shut down. As a 
preliminary step, ensure that all programs have been stopped.  

b. Power off the chassis by entering the following command in the terminal window(s) 
shutdown –h now 

c. After a short time, the cRIO node LED in the upper left corner of the chassis will turn off. 
Note that if network hub is still powered on LEDs on the cRIO node ethernet port may 
stay illuminated, but LEDs on the storage drive and GPS module should also turn off. 

d. When chassis is shut down, one can safely disconnect the power cable from the chassis. 
 
Conversion of LabVIEW binary files to .wav format 

e. Once files are copied to the field laptop (or any other Windows computer), the binary files 
created by LabVIEW can be converted to .wav file format using a program called 
bin2wav.exe. 

f. Select the bin2wav icon  from the taskbar. 
g. In the front panel, select a local .bin file to be converted to .wav format.  
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h. Use the dropdown menus to select desired wav file scale and nominal microphone 
sensitivity. 

i. Run the program by pressing the  button. If wav-file conversion settings are such 
that output was clipped, a red indicator will appear at the bottom of the window. This is 
not an indication that the signal was clipped during acquisition of data in the original 
binary file. 

j. If .wav file signal was clipped, raise the output level and re-run the bin2wav program. 
k. Notes:  

i. .wav files are not individually calibrated; selection of sensitivity and output level 
are a convenience to allow user to set the approximate level range 

ii. .wav files are not in broadcast wav file format; no starting time of day information 
is included in the .wav file metadata  

iii. VRTA.exe can read binary files from VSLM without conversion to .wav format. 
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Useful Information 
 

Time synchronization indicator LEDs 
• MasterClock GPS-200A 

o Solid green LED: power on, searching for satellites 
o Blinking green LED (once per second): satellites acquired, generating timecode signal 
o Blinking green LED (twice per second): satellite signals lost, generating timecode 

signal in freewheeling mode 
• NI-9467 GPS module 

o Blinking amber LED: not enough or no satellites 
o Blinking green LED: searching for satellites and performing survey 
o Solid green LED: normal operation, timing information available 
o Solid yellow LED: antenna error 

cRIO recording node: 
• If unable to connect to cRIO recording node(s) in PuTTY, start NI-Max from start menu and 

expand “remote systems” in left pane. Check that node is connected and verify IP address. If 
IP address is different than expected, use address indicated in NI-Max. 

• Some useful Linux commands: 
o df -h: Shows the amount of free disks space on cRIO node. This is useful for 

determining volume labels of storage drives 
o cd: change directory (examples: cd /media/sdb1, or cd .. to go up a directory) 
o mkdir: make a directory 
o ls –lh: list directory contents and file sizes 
o pwd: returns the working directory 
o tail –n 20 ./file.txt: shows the last twenty lines of “file.txt” (or however many lines you 

want to see). Useful if you want to look at the last few log entries without 
downloading the file 

• To shut down cRIO, enter the following command in the terminal window shutdown –h now 

VRTA: 
• The Volpe Real Time Analyzer (VRTA) program is installed on the field laptop. To start it, select 

the VRTA icon  on the taskbar. 
• Basic instructions for VRTA can be found in the “about” tab. 
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Table 17 - Inventory of CARS System Components 

Component Model Quantity 
Recording node NI cRIO-9037 2 

2 analog input module NI-9250 2 
3 analog input module NI-9232 6 

SSD in c-series module housing Arcale 500 GB 2 
GPS time sync module NI-9467 2 
Time code generator Master Clock GPS-200A 2 

GPA antenna  4 
Gain amplifier B&K Nexus 2693 4 
Microphone GRAS 40 AO 16 
Preamplifier B&K 2671 16 

Gigabit network switch Ubiquiti 1 
Field laptops Dell Latitude 5424 Rugged 2 

12V SLA battery varies 10 
Sound level calibrator B&K 4231 2 
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9.  Appendix B: Volpe START System 

9.1 START User Guide 

1. Overview 

Survey and Tracking Apparatus for Research in Transportation (START) is a GNSS based vehicle tracking 
and surveying platform developed by Volpe. It is designed to support vehicle noise measurements by 
providing highly accurate positioning and timing information for the widest possible range of vehicles and 
use cases. In order to achieve this high level of adaptability, the platform is built around a core of small 
substitutable parts that may be optimized to accommodate the characteristics of the vehicle of interest.  

The platform is comprised primarily of low cost consumer off-the-shelf (COTS) products that have been 
configured for the purpose of collecting and storing raw satellite observations suitable for post-
processing. With a reference receiver at a “known” position on the ground (Base Station), and a second 
receiver, either at a position to be surveyed or mounted on a vehicle of interest (Rover), the two sets of 
satellite observations may be post-processed to produce highly accurate positioning and timing 
information. In most cases, the relative position accuracy of surveyed points and Rover data will be within 
a few centimeters. Such enhanced accuracy, beyond what is possible with a single point solution, is 
required for determining the time-space-position relationship between measurement microphones and 
the noise source.  

The following guidance will identify the hardware components and provide step by step procedures for 
the setup and operation of all hardware and software. Additional information is provided in the 
appendices and includes: data integrity verification procedures, troubleshooting guidance, vehicle 
mounting solutions, receiver configuration settings, hardware dimensions/weights, and links to technical 
resources for more detailed information regarding system components. 

2. Hardware 

The following section provides system diagrams for the Rover and Base station setups (figures 1 and 2), 
followed by a complete list of parts which define the various configuration options that are available in 
the START platform. The numbered items represent the components required for a functional system 
configuration and the lettered items indicate the available options. Photos of select hardware 
components are also provided (Figure 45 and Figure 46). 
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2.1 Hardware diagrams 

*GNSS Receiver

START Rover Control 
Computer

Running Windows 10
with u-blox u-center

 Software

USB Battery Pack:
5V/min. 2A output

4000 – 6000 mAh capacity

             *Antenna Ground Plate

USB A – USB Mini B Cable
(Receiver Cable)

USB A – USB Micro B Cable
(Power Cable)

Integrated antenna cable 
with SMA connector

HDMI Field Monitor

Not to Scale

Wireless “dongle” 
Keyboard

Mini HDMI – HDMI Cable

USB Battery Pack
5V/min. 2A output

min. 20000 mAh capacity

USB A – USB Micro B Cable
(Power Cable)

LEGEND:
Rover Hardware Components
Cables
For Rover configuration setup 
and data capture start/stop 
only

*GNSS receiver, antenna & ground 
plate may be integrated depending on 
receiver variant chosen for deployment 

*GNSS Antenna

 

Figure 45 - START Rover setup 
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GNSS Receiver

             Antenna Ground Plate

USB Mini B – USB A Cable
(Receiver Cable)

Integrated antenna cable 
with SMA connector

Not to Scale

Laptop: Windows 10: with u-blox u-center software

12 VDC Battery

Power Inverter

Laptop 
Power 
Supply

GNSS 
Antenna

 

Figure 46 - START Base Station setup 

 

2.2 START hardware with available options 

The following list of components represents the hardware options that Volpe currently has available. It 
should be noted that multiples of each part are recommended based on anticipated needs for testing 
multiple vehicles within a day or having a sufficient number of spare components to substitute in the vent 
of equipment failures or damage occurring in-use. 

2.2.1 ROVER 

1. START Rover Control Computer - Windows 10 OS, running u-blox u-center v19.01 or later  
a. Intel Compute Stick - primary 
b. ACEPC W5 Pro mini - backup 

 
2. GNSS Receiver 

a. u-blox NEO-M8T X-Series – recommended for most applications: integrates active antenna 
and ground plate 
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b. u-blox NEO-M8T USB Dongle – ultra portable, can connect directly to computer or use USB 
ext. cable 

c. u-blox NEO-M8T Pro Version  - integrates active antenna and ground plate. Heavier than X-
Series 
 

3. GNSS Antenna - required with GNSS Receiver option (b) 
a. Tallysman 4721 antenna – multi GNSS, active, patch antenna, excellent directivity 
b. Maxtenna M1516HCT - GPS/GLONASS, passive, helical design, good EMI resiliency 

 
4. Rover USB Battery Pack – dependency between battery weight and capacity (run time) should be 

considered 
a. 4400 mAh, 5VDC/2A  
b. 5000 mAh, 5VDC/2A  
c. 6000 mAh, 5VDC/2A 

 
5. USB Power Cable - available in lengths from 1’ to 3’, select shortest cable installation will 

accommodate  
a. USB A-to-USB micro B, shielded 

 
6. USB Receiver Cable - available in lengths from 6” to 6’, select shortest cable installation will 

accommodate  
a. USB A-to-USB mini B, shielded 

 
7. 64 GB micro SD card – data storage media used in START Rover Control Computer. Multiple micro 

SD cards should be on-hand in order to switch out cards for data quality checks and data backup  
8. Mounting Hardware – 3D printed parts for securing integrated GNSS receivers to vehicle 
9. Wireless “dongle” keyboard/touchpad – for interfacing with START Rover Control Computer 
10. HDMI Field Monitor – for interfacing with Start Rover Control Computer  
11. HDMI-to-mini HDMI cable – connects field monitor to START Rover Control Computer 
12. HDMI(f)-to-HDMI(f) coupler – required to connect HDMI cable to START Rover Control Computer 
13. Field Monitor USB Battery Pack – 24000 mAh: to power Field Monitor, use with USB A-to-USB 

micro B or USB-C cable (depending on Field Monitor) 
2.2.2 BASE Station  

14. Laptop Computer - Windows OS, loaded with u-blox u-center v19.01 or later  
 

15. GNSS Receiver 
a. u-blox NEO-M8T USB Dongle – preferred, can connect directly to laptop computer or use USB 

ext. cable 
b. u-blox NEO-M8T X-Series - integrates active antenna and ground plate 
c. u-blox NEO-M8T Pro Version  - integrates active antenna and ground plate 
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16. GNSS Antenna – for use with GNSS Receiver option (a) 
a. Tallysman 4721 antenna – multi GNSS, active, patch antenna, excellent directivity 

 
17. Antenna Ground Plate – Steel, 77 mm x 79 mm x 2 mm – for use with Tallysman 4721 antenna 
18. 20 – 22 amp-hour sealed lead acid battery  
19. Power inverter - 400 Watt minimum 

 

 
Figure 47 - START Rover hardware featuring integrated receiver/high gain antenna 

6000 mAh 
battery 

Rover Control 
Computer: ACEPC W5 

u-blox NEO-M8T  
X-Series, High 
Gain receiver 

USB Power 
Cable 

USB Receiver 
Cable 
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Figure 48 - START Base Station configuration featuring M8T dongle receiver and Tallysman 4721 active antenna 

3. Field procedures 

3.1 Base Station deployment 

The Base Station (Base) should be set up and initialized prior to the Rover. To achieve best performance, 
it is important that the Base be sited in an open area, free from large reflective surfaces. Allow the Base 
receiver to attain a 3D positioning solution and collect data for at least an hour prior to collecting Rover 
data. The Base should always be collecting data while the Rover is in use since concurrent data is required 
to process corrections. In the event that operating a local Base Station is impractical, an alternative ground 
reference station, such as a Continually Operating Reference Station (CORS) may be substituted during 
post-processing, however advance research is required to ensure suitable proximity to the test site. More 
information on the use of CORS is available in Volpe’s “GNSS Data Processing Guidance”. The following is 
a step-by-step setup procedure for the START Base Station. 

1. Connect Tallysman 4721 GNSS antenna to u-blox NEO-M8T USB dongle receiver by rotating the 
SMA connector clock-wise onto the threaded coaxial connector at the receiver. 

u-blox M8T 
USB dongle 

 
Tallysman 4721 
antenna 
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2. Connect the u-blox receiver to the Base Station laptop using a USB Mini B-to-USB A cable. The 
USB dongle version of the u-blox receiver may be plugged directly into the laptop USB port. 
Alternatively, the u-blox NEO-M8T X-Series integrated receiver, antenna and ground plate may be 
connected to the laptop USB port. 

3. To ensure adequate runtime power, connect a power inverter (min. 400 Watts) to a 20 – 22 Ah, 
12 volt sealed lead acid (SLA) battery. Next, plug in the laptop power supply at the inverter and 
insert power plug into the laptop power jack. 

4. Place the GNSS antenna on the ground plate and mount on a tripod so that the plate is level and 
antenna is oriented to the sky. Position as far from other objects as the cables will comfortably 
allow.  

NOTE: Do not move this antenna once the Base Station antenna position has been established. If 
testing is occurring over the course of more than one day, it is critical to mark the position and 
accurately reestablish the Base antenna position and directional orientation each time the Base 
Station is setup. 

5. Turn on the laptop. The laptop will supply power to the receiver and antenna via the USB 
connection.  

6. Create a root-level data directory for the START Base Station file(s) to be written. Name data 
folder using the following format: BASE_<test site name>_<date:mmddyyyy>  

7. Set Com Port parameters in Windows:  
a. From the Start menu, right click and select Device Manager.  

Note: Steps to access the Device Manager may vary slightly depending on the Windows 
OS. 

b. Scroll down the Device Manager to Ports (Com & LPT) and expand the menu. Depending 
on the driver, you will see the u-blox receiver listed as “u-blox GNSS Receiver”, “USB Serial 
Device” or “u-blox virtual com port”. Note the com port number assignment (Figure 49). 

c. Next, double click the receiver port assignment and select the Port Settings tab. Change 
the Bits per second setting to 115200, using the dropdown menu. Other settings should 
use defaults. Click OK and exit Device Manager. 
 

8. Open the u-center software using the desktop shortcut. 
Note: for detailed information regarding u-center functionality, refer to u-center User’s Guide 
which is located in the C:\Program Files(x86)\U-blox \u-center folder. 

a. Using u-center drop-down menus, go to Receiver > Connection. Select the com port that 
corresponds to the u-blox receiver (step 7b above). 

b. Next, go to Receiver > Baudrate and select 115200. 
c. Load the Base Station Configuration Settings: go to Tools > GNSS Configuration (Figure 

51). Under Configuration file, use the Browse button to select 
“M8T_Integr_High+Dongle_Base_040221-10Hz” and press Open. Next, press File > GNSS 
button to load preconfigured settings to u-blox receiver. 
 

              NOTE: Although the receiver begins searching for satellites and converging on a positioning 
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solution as soon as power is applied, a new solution must be attained each time a new settings 
configuration is loaded. This process can take up to several minutes. As satellites become visible, you will 
notice activity in the docking windows to the right. 

d. The window in the upper-most right of u-center is the Data View and indicates current 
latitude/longitude, altitude (re: WGS84 ellipsoid) and Fix Mode, among other useful 
information. Desirable fixes include 3D or 3D/DGNSS, the latter of which indicates that 
WAAS satellites are being used in the solution. Other docking windows can be added (or 
removed) by clicking on their respective taskbar icon to display parameters of interest 
such as satellite level history and signal strength (Figure 52).  

e. Next, confirm critical device settings. Go to View > Message View, then maximize the 
message window. At the left, there will be an expandable menu of parameters. Scroll 
down and expand the UBX section, then expand CFG (Config) sub-section which lists the 
receiver configuration parameters: 
i. Click NAV5 (Navigation 5). Under Navigation Modes, the Dynamic Model setting 

should be set according to the use case. Since the Base station is a fixed position, 
“Stationary” will be the appropriate setting (Figure 53).  

ii. Also in the NAV5 settings, under Navigation Input Filters, ensure that “Min SV 
Elevation” = 5 (degrees). 

iii. Go to RATE parameter and ensure that Time Source is set to UTC and Measurement 
Period = 100 ms. 

NOTE: An expanded list of configuration settings with corresponding screenshots of the u-center 
interface can be referenced in Appendix D. Additionally, a detailed explanation of each setting 
can be found in the “u-blox8-M8_ReceiverDescrProtSpec (UBX-13003221)Public” interface 
manual (see Appendix F for link). 

f. Next, expand the MON (Monitor) sub-section and check the following diagnostics: 
i. HW (Hardware Status): Jamming Status indicator should be green (OK) and CW 

Jamming Indicator value should generally be below 10%. If these parameters are not 
met, efforts should be made to mitigate the effects of EMI. Repositioning the Base 
Station antenna or using a USB extension cable when using the dongle receiver are 
recommended first steps. 

ii. TXBUF (TX Buffer): Pending Bytes column should be all zeros.  
g. Expand the RXM (Receiver Manager) sub-section and check the following: 

i. Go to RAWX (Multi-GNSS Raw Measurement Data). Ensure stream of GNSS 
observations can be viewed. A new line of data should appear 10x/second. 

ii. Go to SFRBX (Subframe Data NG): Ensure data is updating every few seconds. 
h. Once a 3D or 3D/GNSS Fix Mode (solution status) has been achieved and critical device 

settings (i.e. steps e, f, and g above) have been checked, begin data recording. 
 

9. To initiate data recording in u-center, press the record button (red circle) in “tape shuttle” 
control section located above the main data window. 
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a. A “Save As” window will open with a default file name consisting of the com port number 
the receiver is connected to and the date and time corresponding to when the Record 
button was clicked. 

b. Navigate to the Base Station data folder created in step 6 and rename the default file 
name, replacing the com port information with “Base_<site name>” and leaving the 
timestamp, e.g., Base_JBCC_220222_223540. 

c. Press Save. When prompted to add receiver configuration to file, select Yes. 
d. Base station data is now being stored is the form of GNSS observables (raw signal data 

from the available satellites). The Stop/Eject button, directly to the left of the Record 
button, should now appear black. This button will be gray and inactive when not in either 
Record or Playback mode. 

e. The Base station must continue to collect data throughout the measurement period. It is 
recommended to occasionally monitor the u-center software to ensure that data is 
recording as expected and solution quality is sufficient as indicated by a 3D fix mode.  

f. After measurement activities are complete for the day, click the Stop/Eject button (Figure 
50) immediately to the left of the Record button. For large files, there may be a delay of 
a minute or more as u-center closes out and saves the data file. Once the Stop/Eject 
button turns gray and satellite data resumes streaming in the docking windows, Exit u-
center.  
 

 
Figure 49 - Device Manager allows access to the u-blox GNSS receiver port settings 

 

 
Figure 50 - Magnified view of Stop/Eject and Record buttons in u-center. The black Stop/Eject color indicates that data 

recording is active 
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Figure 51 - GNSS Configuration tool can be used to load or save receiver configurations 

 

 
Figure 52 - u-center UI features configurable "docking windows" which display various parameters of interest 

Satellite level history 

Satellite signal strength 

Data view 

Satellite position 
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Figure 53 - Message View configuration menu (left) and NAV5 settings (center) 

3.2 Rover deployment 

As a best practice, it is advisable to test all START components prior to scheduled use. If multiple START 
systems will be required, core components (GNSS receiver/antenna, battery and START Control 
Computer) should be matched into complete START systems and tested to confirm functionality. The 
tested systems should be subsequently labeled so that the paired components can be easily identified for 
later Rover deployment. 
An additional best practice is to keep a START log. A separate log should be kept for each deployment and, 
at a minimum, include test site, date, field operator, vehicle-under-test and/or survey being performed, 
components used in START deployment, data file name, and active times. For example, in the case of 
aircraft noise measurements, the takeoff and landing times within each data file are helpful for data 
processing. When performing position surveys, log the beginning and end time of data collection for each 
point surveyed. If START is to be deployed on vehicle, it is useful to measure and log the maximum levels 
of electromagnetic emissions taken at 1 foot (nominal) around the test vehicle. Such information will help 
inform the mounting position and could help explain potential data anomalies, if encountered. More 
information is available in Appendix II: Troubleshooting Guidance. 

3.2.1 Vehicle mounting and considerations 

If using the Rover for surveying static positions on the ground, e.g., microphone locations, then skip to 
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section 3.2.2. If installing the Rover on a vehicle, then careful consideration must be given to the selection 
of components, cables and mounting aides when optimizing the hardware configuration. Access to test 
vehicles is highly recommended, in-advance of testing to, preferably, install START on all vehicles planned 
for next day’s activities or alternatively, to evaluate options, plan mounting strategy and evaluate EMI, as 
each vehicle will present unique challenges which are best considered prior to test day. Either way, 
mounting START hardware is safety critical, mission critical and time consuming, hence there should be 
ample time scheduled for installations. Factors to consider include: vehicle size and weight, physical 
layout, payload capacity, aerodynamics, center of gravity and inertial properties (especially important in 
smaller vehicles), dedicated payload area or flat surfaces to be used as mounting points, ample clearance 
from rotors/engines and potential EMI sources, such as RF antennas. All mounting configurations should 
be tested with the vehicle powered so that potential EMI issues may be identified. Special care must be 
taken to ensure that, both, the host vehicle does not interfere with START GNSS reception and that START 
does not interfere with the operation of the host vehicle’s avionics. For more information on 
troubleshooting EMI issues, refer to Appendix II.  
 
Generally, the hardware components should be mounted first, with the GNSS antenna always positioned 
to maximize a clear view of the sky in both azimuth and elevation. Cable lengths should be no longer than 
required to link components, and safety concerns, such as blade clearance, should be assessed prior to 
the powering of system components. Cables should be secured in multiple locations with little to no slack. 
USB connections should be reinforced to prevent unintended dislodging or movement. All START 
hardware components should have a primary means of mounting and a secondary restraint or failsafe in 
the event a primary mount fails. For example, if the primary mounting technique relies on double-stick 
adhesive, then a secondary restraint may consist of cable ties fastened to tie-down points. Additionally, 
the placement and mounting of all START components must be approved by the vehicle pilot and Volpe 
START operator.  
Since multiple test vehicles and START systems may be deployed for a given flight test, it is highly 
recommended to implement a “START readiness system” to ensure that each START system has been fully 
installed, secured, and that each test vehicle has been cleared for operation. A robust START readiness 
system should include multiple checks such as color-coded stickers to indicate “Ready/Not Ready” status 
for each test vehicle, as well as a radio call from the test director confirming readiness status. Appendix 
III contains additional recommendations for START Rover installation and illustrates examples of mounting 
aides and configurations. 

3.2.2 Set up and initialization 

The following steps apply whether START is mounted on a vehicle or being used to survey locations.  
1. For most use cases, the u-blox NEO-M8T X-Series receiver, which integrates GNSS receiver, 

antenna and ground plate, is recommended. This option is generally preferred because it 
simplifies the setup, requires fewer cable connections, provides high signal gain and has 
flexible mounting hardware. For situations where the physical characteristics of the vehicle 
cannot accommodate an integrated receiver, a separate receiver, antenna and ground plate 
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may be used. If using separate components see steps (a) and (b) below. Otherwise, skip to step 
2. 

a. Connect GNSS antenna to u-blox NEO-M8T receiver by rotating threaded coaxial 
connector to SMA jack on USB dongle receiver variant. The Tallysman 4721 is the 
preferred GNSS antenna, however the Maxtena antenna may be a better choice in 
space-constrained settings as it does not require a ground plane and may be oriented 
on or off axis.  

b. If using the Tallysman 4721 antenna, affix to largest diameter aluminum ground plate 
suitable for application. 

2. Ensure that the GNSS antenna has clear line-of-site to open sky. 
3. Connect the u-blox receiver to the START Rover Control Computer using a USB Mini B-to-USB 

A cable. 
4. Connect START Rover Control Computer to fully charged USB Battery Pack using USB micro-B 

(Computer) to USB A (battery) cable. There are three START Rover battery capacities available: 
4400, 5000 and 6000 mAh. In order to minimize down-time, it is generally advisable to use the 
highest capacity battery that the vehicle can safely carry without degrading its performance or 
reducing flight time to impractical durations. Appendix E contains a table with weights and 
dimensions of key system components, as well as weights for preferred configurations, as 
installed on vehicle. 

5. Power up system: 
a. START Control Computer may automatically power up when battery is connected (step 

4). If not; 
b. Press button on Rover battery pack (LEDs will illuminate).  
c. Then, power computer by holding side power button for 2 seconds, or until LED on the 

computer lights up. When booting up, it is typical for the START Control Computer LED to 
briefly illuminate then turn off for a few seconds before it reappears. Do not repeatedly 
press the power button. 
 

6. Set up the keyboard and monitor to interface with the Rover (figure 10): 
a. Place the HDMI display on its stand and connect to the large, 24000 mAh, USB Battery 

Pack. Adhere the battery pack to the back of the monitor using the “Dual-Lock” faster 
strips. 

b. Connect the START Rover Control Computer to HDMI display using the fiber-optic HDMI-
to-mini HDMI cable and female-to-female HDMI coupler.  

c. Plug in the wireless keyboard’s USB dongle to an open port of START Rover Control 
Computer. Turn on wireless keyboard/touchpad (front), then right-click to open Windows 
desktop environment. 
NOTE: if using multiple wireless keyboards to interface with multiple START systems, it 
recommended to color-code keyboards with their paired USB dongles. 
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7. Adjust Windows time and date and ensure that it is nominally synchronized (+/- 2 sec) to the 
designated “master clock”: 
a. Place cursor over date/time field at lower right of display, right click, and select Adjust 

date/time.  
b. Check Time zone for appropriate setting.  
c. If enabled, turn off “Set time automatically”.   
d. Next, click the Change button and use the popup to set the proper time, then close out of 

Settings.   
 

8. Ensure that a microSD card with adequate storage capacity is loaded in the card slot.                      
9. Create a root-level data directory on the C drive for the Rover files to be written.  

a. A test site/date-specific directory should be created for each day of measurements. 
b. Within each daily directory, a folder should be created for every vehicle tested or survey 

performed. Name data folders using the following convention: ROVER_<vehicle name or 
survey point name>_<test site name>_<date:mmddyyyy>  
 

10. Set Com Port parameters in Windows:  
a. From the Start menu, right click and select Device Manager.  
b. Scroll down the Device manager to Ports (Com & LPT) and expand the menu. Depending 

on the driver, you will see the u-blox receiver listed as “u-blox GNSS Receiver”, “USB Serial 
Device” or “u-blox virtual com port”. Note the com port number assignment. 

c. Next, double click the port assigned to the u-blox receiver and select the Port Settings tab. 
Change the Bits per second setting to 115200, using the dropdown menu. Other settings 
should use defaults. Click OK and exit Device Manager. 
 

11. Open u-center software using the desktop shortcut: 
a. Using u-center drop-down menus go to Receiver > Connection. Select the com port that 

corresponds to the u-blox receiver listed in step 10b. 
b. Next, go to Receiver > Baudrate and select 115200. 
c. Load the Rover Configuration Settings: go to Tools > GNSS Configuration. Under 

Configuration file, use browse button to select 
“M8T_Integr_High+Dongle_Rover_040221-10Hz” and press Open. Next, press File > GNSS 
button to load preconfigured settings to u-blox receiver.  

NOTE: Although the receiver begins searching for satellites and converging on a positioning 
solution as soon as power is applied, a new solution must be attained each time a new settings 
configuration is loaded. This process can take up to several minutes. As satellites become visible, 
you will note activity in the docking windows to the right. 

d. The docking window in the upper-most right of u-center is the Data View (figure 8) and 
indicates current latitude/longitude, altitude (re: WGS84 ellipsoid) and Fix Mode, among 
other useful information. Desirable fixes include 3D or 3D/DGNSS, the latter of which 
indicates that WAAS satellites are being used in the solution. Other docking windows can 
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be added (or removed) to display parameters of interest such as satellite level history and 
signal strength.  

e. Next, confirm critical device settings. Go to View > Message View, then maximize the 
message window. At the left, there will be an expandable menu of parameters. Scroll 
down and expand the UBX section, then expand CFG (Config) sub-section which lists the 
receiver configuration parameters: 
i. Click NAV5 (Navigation 5). Under Navigation Modes, the Dynamic Model parameter 

should be set according to the Rover use case. For most small UA, “Airborne < 1g” 
(acceleration) will be appropriate, however, this setting should be optimized for the 
specific end-use. For example, for very fast moving UA, “Airborne <2g” should be 
used. For surveying microphone positions, this setting should be changed to 
“Stationary”. 

ii. Also in the NAV5 settings, under Navigation Input Filters, for any dynamic use case, 
ensure that “Min SV Elevation” = 0. For “stationary” applications, set to 5. 

iii. Go to RATE parameter and ensure that Time Source is set to UTC and Measurement 
Period = 100 ms. 

NOTE: An expanded list of configuration settings with corresponding screenshots of the u-center 
interface can be referenced in Appendix D. Additionally, a detailed explanation of each setting 
can be found in the “u-blox8-M8_ReceiverDescrProtSpec (UBX-13003221)Public” interface 
manual (see Appendix F for link). 

f. Next, expand the MON (Monitor) sub-section and check the following diagnostics: 
i. HW (Hardware Status): Jamming Status indicator should be green (OK), although 

yellow (warning) may also be acceptable. The CW Jamming Indicator value should 
generally be below 20%. If these parameters are not met, efforts should be made to 
mitigate the effects of EMI. Potential solutions include repositioning the Rover 
Control Computer to avoid EMI “hot spots”, and/or applying shielding material. 
Appendix B: “Troubleshooting guidance”, provides additional information as well as 
screenshots and tips regarding diagnostics and potential solutions to EMI induced 
issues. 

ii. TXBUF (TX Buffer): Pending Bytes column should be all zeros.  
g. Expand the RXM (Receiver Manager) sub-section and check the following: 

i. Go to RAWX (Multi-GNSS Raw Measurement Data). Ensure stream of GNSS 
observations can be viewed. A new line of data should appear 10x/second. 

ii. Go to SFRBX (Subframe Data NG): Ensure data is updating every few seconds. 
h. Once a 3D or 3D/GNSS Fix Mode (solution status) is achieved and critical device settings 

have been confirmed, perform a time check against the acoustic data collection system’s 
reference time. 
i.     To view START system time, use time display at lower right corner of u-center GUI 
and ensure that it  
       matches the time of the acoustics system. 
ii.    Record a “time hack” file by pressing Record button. When “Save as” window appears, 
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add prefix   
       “time_hack” to default file name and press Save. Select, Yes when prompted to load 
log file   
        and data capture will begin. 
iii. Coordinate time check with acoustics operator. As the acoustics operator calls out 

the time, press the Stop/Eject button at the moment of the audible time mark. The 
last timestamp of the “”time Hack” file should match the time mark within a tolerance 
of 1 second.  

i. Once synchronization between data collection systems has been confirmed, data 
recording can begin. 
 

12. To initiate data recording in u-center, press the record button (red circle) in “tape shuttle” 
control section located above the main data window. 
a. A “Save As” window will open with a default file name consisting of the com port number 

the receiver is connected to and the date and time corresponding to when the Record 
button was clicked. 

b. Navigate to the Rover data directory created in step 9 and rename the default file name, 
replacing the com port information with “<vehicle name>_<sequential file #>” and leaving 
the timestamp, e.g., M210_1_220222_223540. Sequential file numbers should follow the 
vehicle name since there are typically several data files that will be recorded for each test 
vehicle. 

c. Press Save. When prompted to add receiver configuration to file, select Yes. 
d. Rover data is now being stored is the form of GNSS observables (raw signal data from the 

available satellites). When recording is in progress, the Stop/Eject button, directly to the 
left of the Record button, will appear black (figure 6). This button will appear gray and be 
inactive when not in either Record or Playback mode. 

e. It is recommended that the Rover collect data for at least 10 minutes prior to vehicle 
testing. When ready, disconnect the display monitor from the START Rover Control 
Computer and turn off the keyboard. To minimize handling and facilitate data card and/or 
battery swaps, the wireless keyboard dongle may be left in the Rover Control Computer. 
The Rover is now ready for use. 
 

13. Data integrity checks should be performed at moments of opportunity during and after a 
vehicle measurement, e.g., vehicle battery changes or other down time during testing: 
a. Reconnect the HDMI display monitor to the Rover Control Computer and turn on the 

keyboard. 
b. Press the keypad to “wake up” the display monitor, then stop data recording by clicking 

the Stop/Eject button. There will be a delay as u-center closes the file. Wait for the 
Stop/Eject button to become inactive (gray). 

c. Eject the microSD card and replace it with a spare. If testing is still in progress, check the 
START Rover battery to confirm it has sufficient capacity, then initiate a new, sequentially 
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numbered, data file and begin recording. If the battery is running low, a shutdown will be 
required as the battery is not “hot swappable”. 

d. Backup the START Rover data to a field laptop, then evaluate the data for completeness 
using the VerifyRINEX Software Utility, which should be installed on the field laptop. For 
step-by-step details on using VerifyRINEX, refer to Appendix A. 
 

14. After measurement activities are complete for the day, click the Stop/Eject button 
immediately to the left of the Record button. For large files, there may be a delay of a minute 
or more as u-center closes and saves the data file. Once the Stop/Eject button becomes 
inactive (gray) and satellite data resumes streaming in the docking windows, Exit u-center.  

15. START may be either extracted or left deployed on the test vehicle with consideration given to 
the test schedule and the number of available START components. 

 
Figure 54 - Equipment used to interface with START Rover: configure and start/stop data collection 

Appendix I: Verifying integrity of GNSS 
observations 

To mitigate the potential for missing or incomplete START Rover GNSS data, it is recommended that the 
data contents be verified for completeness, both, during and after each vehicle is tested. Ideally, data 
verification should be performed during battery changes or refueling of test aircraft and after test events 
have been completed. The START Rover should not be extracted from the vehicle until data completeness 
has been verified. To accomplish this, VerifyRinex, a console application intended to quickly assess 
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completeness and integrity of tracking system data has been developed by Volpe. The utility was written 
and tested for use with the RINEX v3.03 specification.  
 
Following is a step by step procedure for GNSS data verification using VerifyRinex. 

1. During testing “down time”, remove micro SD card from START Rover Control Computer. 
2. Insert card in designated field laptop (a USB card reader may be needed). Laptop should be 

preloaded with the RTKLIB suite of GNSS processing tools as well as VerifyRinex software (most 
recent revision available).  

3. Convert proprietary u-blox “.ubx” data file of interest to standardized RINEX v3.03: 
a. Within the RTKLIB folder, right click on “rtkconv.exe” and open as administrator. For 

future ease of access, it is recommended to create a desktop shortcut. 
b. Select Rover data file as the input by clicking upper most directory button along right edge 

of user interface. Navigate to relevant data file and select. Directory location should be 
visible at top drop-down field, under “RTCM, RCV RAW or RINEX OBS” (Figure 55). 

c. Next, click directory button to the right of the “Output Directory” drop-down field and 
navigate to desired folder.  

d. Under “Format”, to the right of the Output Directory field, use the drop-down menu to 
select “u-blox”. 

e. Ensure checkbox under Output Directory (at far left of UI) is selected as well as top two 
checkboxes under RINEX OBS/NAV…  

f. Set options by clicking on “Options” button at center bottom of UI. Popup will appear. 
g. Set RINEX version to 3.03 using drop- down menu at top left (Figure 56). 
h. Ensure that “Scan Obs Types” is checked. 
i. Under Satellite Systems, check GPS, GLO, GAL and SBS. 
j. Check all boxes under Observation Types and ensure that L1 is checked under 

Frequencies. Click OK to close Options. 
k. Next, click the Convert button to generate RINEX v3.03 files to the output directory. The 

file with the “.obs” extension contains the GNSS observables and will be used with the 
VerifyRinex utility. 

4. Copy the .obs RINEX file into the VerifyRinex folder, which contains the VerifyRinex executable, 
input configuration file (VRinput.txt), output file (VRoutput.txt) and logs of detailed timestamp 
information (timestamps.log & missing_timestamps.log). 

5. Next, double-click the RINEX file, generated in step 3, to open. After the header information you 
will see timestamps with subsequent GNSS observables. To check the entire file, note the first and 
last timestamp. If a subset of data is being checked, such as events of interest from a field log, 
then enter those start/end times (UTC). 

6. Open VRinput.txt and enter parameters for the data being verified. The input configuration file 
must be formatted according to Figure 57. The parameters include the name of the RINEX file 
(no spaces or special characters permitted), start/end dates and times of data to be verified, Rover 
data sampling rate (Hz), a minimum threshold number of satellites (recommend 8 -10) and a 
binary value to turn off/on the timestamp logs. See table A-1 for a summary of VRinput.txt fields 
and formatting. When complete, Save and close VRinput.txt. 

7. Run the utility by double-clicking VerfifyRinex.exe. The utility parses the RINEX file while counting 
the number of timestamp records that fall within the user-specified window. Based on the 
sampling rate a certain number of records will be expected. The number of located records and 
the expected number of records are displayed on the screen and written to VRoutput.txt. 
Additionally, the number of satellite observations in each record is compared against the 
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minimum threshold value and the percentage of records in which the number of satellites meets 
the threshold is also reported. Optionally, both a list of timestamps and satellite counts for all 
records within the user-specified interval is written to the “timestamps.log” and a listing of all 
missing timestamp records (> 1 sec), including duration of gap and start and end points, is 
provided in the “missing_timestamps.log”. 

8. It is generally expected to have near 100% of anticipated records and at least 5 satellites per 
record. Data gaps, if any, should be no more than a few seconds. The timing of missing data points 
is the critical factor though. Special attention should be paid to times when the Rover was engaged 
in flight test events. Based on the completeness of data, a decision may be made to collect 
additional data.   

 

 
Figure 55 - RTKConv converts the u-blox GNSS data format to RINEX  
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Figure 56 - RTKConv Options settings 

  

 
Figure 57 - Required input parameters for VRinput.txt 

 
Table 18 - Required format and contents of VRinput.txt 

Line number Input field Format / units 
1 RINEX file name filename.obs 
2 Start date YYYYMMDD 
3 Start time HHMMSS 
4 End date YYYYMMDD 
5 End time HHMMSS 
6 Sampling rate Hz 
7 Threshold number of satellites Integer 
8 Optional flag for timestamp output 1 (to write timestamp file) or blank 
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Appendix II: Troubleshooting guidance 
The following section presents potential problems that could be encountered while using START. It is 
based on user experience and is by no means a comprehensive listing of every issue that could occur. For 
each issue presented below, guidance is given to solve or work around the obstacle at hand. 
 

1. START Rover data dropouts are observed in, either, u-center’s Satellite Level History display or 
discovered via the VerifyRinex data integrity check. 

Regardless of how the dropouts are discovered, it is likely that the dropout are being caused by 
electromagnetic interference (EMI) from the host aircraft. There are two general types of EMI to 
be concerned with, broad band and narrow band. This is important because they tend to have 
different sources within the aircraft and since the u-blox receiver monitors both, this feedback 
can be used to diagnose and remedy the issue. The goal is to mitigate interference levels to 
tolerable levels as it is generally not possible to completely eliminate it. 
The following procedures are recommended to mitigate EMI to levels that do not compromise 
data integrity: 

a. If not already running, open u-center software using the desktop shortcut. 

b. Go to View > Message View, then maximize the message window. At the left, 
there will be an expandable menu of parameters. Scroll down and expand the 
UBX section. Next, expand the MON (Monitor) sub-section and check the 
following diagnostics: 

c. HW (Hardware Status) (Figure 58): Jamming Status indicator should be green 
(OK), although yellow (warning) may also be acceptable. The CW Jamming 
Indicator value should generally be below 20% when the START Rover is 
onboard a powered aircraft. If these parameters are not met, efforts should 
be made to mitigate the effects of EMI. Potential solutions include 
repositioning or reorienting the START Rover Control Computer or the 
receiver, inserting an in-line noise filter between the Rover battery and START 
Rover Control Computer and applying shielding material.  

d. An iterative process using, both, an EMI detector (Figure 59) and the u-center 
HW jamming indicators in conjunction with mitigating efforts will be required 
to find the right solution or combination of solutions. To help accomplish this, 
a better understanding of key Hardware Status (HW) parameters is useful: 

(1) The Jamming Status indicator accounts for total radio 
frequency interference (RFI). This means that both broad and 
narrow band spectra are monitored. However, the indication 
is relative to the last time the receiver attained a valid 
solution with an “OK” jamming status. A default threshold of 
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3 dBHz is used. If the state changes from OK (green) to 
Warning (yellow), this means that >3 dBHz RF “noise” has 
been detected relative to the last time the receiver had a 
valid solution with an “OK” jamming status. A Warning 
(yellow) jamming status is not necessarily a problem though. 
This information must be considered along with the CW 
Jamming Indicator as well as satellite signal levels, as 
represented by the carrier-to-noise density ratio(s) (C/N0)).  A 
Jamming Status of Critical (red) is always a problem, 
however, and typically means that interference is preventing 
a valid fix from occurring. 

(2) The CW (constant wave) Jamming Indicator monitors 
narrow-band EMI. A desirable value is generally under 15%, 
although this is not an absolute rule and can vary depending 
on local environment. In all cases though, the lowest value 
attainable is desired. Strong sources of CW interference are 
typically driven by telemetry occurring between the aircraft 
and controller. Most aircraft will have multiple antennae and 
more than one frequency used for communicating different 
types of data, e.g., control information versus video feed.  

(3) Carrier-to-noise density ratio (C/N0) is a measure of signal 
power expressed in decibel-Hertz (dBHz) and refers to the 
ratio of the carrier power and the noise power per unit 
bandwidth. C/N0 values are available for every satellite 
received and can be viewed either in numerical or graphic 
form. The easiest way to monitor C/N0 levels are via the 
Satellite-Levels docking window as indicated by the vertical 
bars at the lower right of Figure 58. Using the Satellite-Levels 
History window (window showing flags of origin for 
satellites), you can click on the horizontal signal level history 
bar to see a readout of satellite C/N0 as well as its position. 
Generally speaking, 30 dBHz is an acceptable value. In 
optimal conditions, and depending on the receiver/antenna 
combination, there should be at least 5 satellites over this 
threshold. Low C/N0 levels in open, outdoor conditions, are 
likely caused by EMI jamming.  

e. An EMI Detector is recommended to identify the sources of EMI and where 
the electro-magnetic field is most intense. This information is useful in 
determining alternative mounting positions and orientations for START 
components. 
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Below are a few example scenarios to explain and explore mitigation options.   

Scenario 1: Jamming Status = Warning, CW Jamming Indicator = 50% 
In this case, the constant wave (narrowband) interference is considerably higher than normal and the 
jamming status of “warning” is likely being driven by the CW levels. The primary RF noise source is 
probably propagating from the various aircraft antennae which are often concealed in spaces like the 
landing gear or wings. An EMI detector should be used to locate the strongest source(s). Once sources are 
confirmed, it is recommended to reorient or reposition START Rover components away from the source. 
An iterative approach using the jamming indicators will be needed. The START Rover battery is the most 
susceptible component in terms of introducing stray RFI into the system, hence this is a practical starting 
point. The GNSS receiver/antenna may also receive stray RF. Repositioning can be effective laterally or 
vertically. Sometimes, simply rotating a component so that the USB connection faces another direction 
can be useful. The in-line noise filter may also be tried in conjunction with this approach. It has been seen 
to reduce some CW interference by as much as 50%. The RF resistant “Faraday Pouch” can also be a useful 
form of shielding, especially where there is not enough space to adequately separate START components 
from the EMI source.  
 
Scenario 2: Jamming Status = Warning, CW Jamming Indicator = 20% 
This is a borderline situation where, although there is considerable CW interference, repositioning 
components may not be necessary. It is not clear if the Jamming Status Warning is being caused by 
narrowband or broadband EMI. It may be a combination of both. Check the C/N0 levels. If there are at 
least 6 or 7 satellites over 30 dBHz then the GNSS signal strength should be sufficiently high to enable 
robust data collection. If multiple signals are over 40 dBHz or higher, then confidence levels are even 
higher. It is, however, recommended to insert the in-line USB noise filter between the Rover battery and 
the Start Rover Control Computer. Recheck jamming indicators, as well as C/N0 levels for indications of 
improvement. 
 
Scenario 3: Jamming Status = Critical, CW Jamming Indicator = 40% 
This scenario is interesting because data collection is failing but the CW Jamming, although considerable, 
is likely not high enough to cause a critical state on its own. The failure is probably being driven by 
broadband EMI. This makes it harder to pinpoint the source, however, using the EMI detector will help 
identify “hot spots”. Typically, poor shielding on aircraft components, such as the motherboard, can emit 
a strong broad-spectrum EMI field. It is also possible for the START Control Computer to contribute to 
broad-spectrum EMI. For this reason it is always recommended to provide as much separation between 
the START Control Computer, battery, and receiver as the installation will allow. Iterative repositioning of 
components will be necessary and is generally the first line of defense to reduce EMI. Reposition 
components away from “hot spots” and check indicators and C/N0 levels for improvement. If the Jamming 
Status is not improved and the CW Jamming indication reduced to at least 20%, then, raise the 
antenna/receiver assembly by stacking an additional mounting apparatus underneath. EMI typically 
propagates in a non-uniform manner so sometimes vertical repositioning may be more effective than 
lateral repositioning. Experimenting with START component placement and orientation should eliminate 
this type of issue, however consideration must be paid to proper load balancing. 
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Figure 58 - u-center Hardware Status provides useful feedback for monitoring EMI 

 

Figure 59 - EMI Detectors are helpful for identifying electro-magnetic "hotspots" during START Rover installations 
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2. START (either Base or Rover) has been properly setup, powered on, and configured but no 
satellites are being received after several minutes of searching. 

Ensure that GNSS antenna has a clear view of the sky. Within u-center, go to Receiver menu and 
select Debug Messages. This action will send debug messages to the receiver and activity should 
be seen in the docking windows within a few minutes. 
 

3. Forgot to initiate data recording. While powered on and after attaining a solution, the u-blox 
receiver continuously collects data to a SQLite database on an internal 4MB flash memory. In the 
event that the recording of the data log was not initiated, it is still possible to recover the last, 
approximately, 5 minutes of data (limitation based on configuration settings and 4MB flash size). 
To recover, go to File > Save. A “Save As” pop up will appear. Rename the file according to protocol 
and choose appropriate directory, then press Save. Data from the last 5 minutes will be captured 
and new data will continue to record until the file is stopped or Ejected. 

4. Loading of START Configuration file fails. This is a rarely seen issue. This is a u-blox bug and is 
best remedied by switching out the Start Rover Control Computer. 

5. Host vehicle is experiencing EMI related issues, e.g., lack of GPS reception. 
This interference is likely caused by EMI produced by the START system. First, disconnect the 
HDMI connection from the START Rover Control Computer to the display monitor and reevaluate 
the problem. The computer is the largest EMI emitter in the START system and its emissions are 
highest when driving the HDMI output. If the problem persists, then iteratively reposition the 
START components and solicit feedback from the vehicle operator until the issue is mitigated. 
Shielding material, such as “Faraday fabric” may be used to isolate the highest emitting 
components if repositioning alone is not effective. 
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Appendix III: Vehicle mounting solutions 
The different configurations of the START Rover system allow for a wide variety of mounting solutions. 
There are, however, a few questions that should be asked to determine the optimal mounting solution.  

• What to mount? Optimize START Rover hardware configuration based on vehicle characteristics, 
(e.g., EMI sources, size and weight constraints) 

• Where to mount? Where will the START Rover components fit and are there features that can be 
used to secure components? 

• How to mount? Choose the best aides to safely secure the system to the vehicle 

There are a number of supplies and tools available. What works best will vary from vehicle to vehicle.  
 
What to Mount  
The current preferred component set uses the u-blox NEO-M8T High Gain integrated receiver and 
antenna, with the 4400 mAH Rover battery. This configuration provides the best performance with a 
relatively low system weight. If vehicle characteristics require scaling down size and weight, use 
shorter/lighter cables and minimize mounting hardware, if viable. If dimensions are an issue, switch to 
the u-blox NEO-M8T “Dongle” receiver and Tallysman 4721 antenna. This option has more flexibility to 
allow components to be placed in tighter spaces. 
 
Where to Mount 
There are multiple goals in positioning the components on the aircraft. Key factors are: 

• placing the antenna to allow a clear view of the sky in both azimuth and elevation 
• finding locations on the vehicle that are flat and smooth (if available) and clear of propellers and 

other moving or functional features 
• balancing the weight of the system on the vehicle as to not impact flight performance, e.g., 

aerodynamics, c.g. and inertial properties (especially important in smaller vehicles). Placing parts 
close to the center of the vehicle helps with balance, as does placing the heaviest components 
opposite of each other or opposite from heavy points on the aircraft (counter-balance). 

• placing receiver/antenna away from known EMI sources, including the START Rover Control 
Computer, which should always be separated from other START components by as much distance 
as the vehicle will allow. Separating the computer and battery by mounting to opposing landing 
gear is often a viable way to achieve balance and control EMI. 

• keeping components protected from environmental extremes is also an important consideration. 
In warm weather, measures should be taken to keep Rover Control Computer out of direct 
sunlight and away from heat generating sources. Consider mounting to the underside of vehicle 
if a suitable mounting point can be located. 

How to Mount 
Mounting must be temporary and should not mar or damage the vehicle, however, must also be secure 
with no chance of components coming loose during the test. Use materials that will accomplish this with 
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the least amount of added weight and impact on the vehicle. Table 19 illustrates useful mounting aides 
and materials. 
 

Table 19 - Vehicle mounting aides for the START Rover 

u-blox 45mm, 60mm and 90mm mounts – 
These 3D printed mounts are made at the 
Volpe Center for the u-blox hardware. They 
are stackable to provide flexibility to move the 
receiver away from the aircraft propellers and 
possible EMI sources. 
 

 
“Dual Lock” fastener – This material is similar 
to Velcro and provides a strong grip with less 
play than fabric Velcro. It is available in regular 
and low profile. 
 
 

 
Cable “zip” ties – Strong, versatile 
connections, but require a place of 
attachment. Smaller ties are important for 
managing cables. 
 

 
Foam – High-density foam is important for 
filling gaps between curved and flat surfaces. 
 

 
 
Important checks!   

1. Keep clear of the props! Make sure all hardware, cables and mounting materials are clear of the 
propellers throughout their full range of motion. 
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2. Make sure you can access important buttons, connections, ports and card slots. This can be as simple 
as confirming the component is facing the right way. 
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Example START Rover Installations: 
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Appendix IV: Receiver configuration settings 
The u-blox NEO-M8T GNSS receiver is a complex device with numerous settings which can be optimized 
for a wide array of precise timing and positioning applications. In most cases, the settings are either not 
relevant for our end-use or the default value is sufficient. This section will illustrate the subset of settings 
that define the START configuration and are most important for the successful collection of GNSS 
observables. It is not recommended to stray from the settings of the START configuration files, unless 
there is a complete understanding of the parameter. Although there are a total of four START 
configuration files, only a few settings differentiate the four configurations. These differences are based 
on whether the application is static (Base Station/Point Survey) or dynamic (Rover), as well as the choice 
of receiver hardware. Configuration differences will be noted for the relevant parameters. 
 
To access configuration settings, Open u-center software using the desktop shortcut: 

1. Go to View > Message View, then maximize the message window. At the left, there will be an 
expandable menu of parameters. Scroll down and expand the UBX section, then expand CFG 
(Config) sub-section which lists the receiver configuration parameters. The following table (table 
D-1) lists the non-default configuration parameters for START. To access settings, click on CFG 
(Config) Parameter listed in the table. To apply any change in settings, the “Send” button in the 
lower left corner of u-center must be clicked subsequent to changing a parameter in the GUI. This 
action will send the new settings to the receiver.  

NOTE: *Indicates parameters that vary across the four START configuration files. 
 

Table 20 - Settings for START configuration 

CFG (Config) Parameter START Configuration Settings 

GNSS (GNSS Config) -Check “Enable” for GPS, min = 8, max = 16 
-Check “Enable for SBAS, min = 1, max = 3 
-Check “Enable” for Galileo, min = 4, max = 8 
-Check “Enable for GLONASS, min = 4, max = 12 

INF (Inf Messages) Protocol – select NMEA, then in column #3, check Error, 
Warning, and Notice. No additional protocols require 
information messages 

*ITFM (Jamming Interference Monitor) Ensure “enable jamming/interference monitor” is checked. 
*Antenna Type depends on hardware choices. Select 
“Active” for Tallysman 4721 and u-blox NEO-M8T High Gain 
integrated receiver/antenna (square plate design). Select 
“Passive” for other hardware options 

LOGFILTER (Log Settings) Check “Recording enabled” 
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MSG (Messages) The following messages should be selected from the drop 
down menu and the USB box should be checked for each: 
MON-HW2, Mon-HW, Mon-IO, MON-TXBUF, NAV-PVT, NAV-
SBAS, NAV-STATUS, NAV-SVINFO, RXM-RAWX, RXM-SFRBX, 
NMEA-GxGGA, NMEA-GxGGL, NMEA-GxGSA, NMEA-GxGSV, 
NMEA-GxRMC, NMEA-GxGVT, NMEA-GxZDA 

*NAV5 (Navigation 5) *For Base Station & Survey applications set Dynamic Model 
to Stationary and Min SV Elevation to 5 (deg) 
*For Rover/Dynamic applications set Dynamic Model to 
Airborne <1g and Min SV Elevation to 0 (deg) 
Default values should be used for all other parameters 

PMS (Power Management Setup) Full Power or Balanced may be selected from drop down 
menu 

PRT (Ports) Select USB from the Target drop down menu. Protocol in & 
Protocol out should be set to UBX+NMEA. All other Targets 
should be set to None. 

RATE (Rates) Time Source = UTC time, Measurement Period = 500 ms 
Default values should be used for other parameters 

SBAS (SBAS Settings) Subsystem = Enabled, PRN Code – select WAAS.  
Default values should be used for other parameters 

USB (Universal Serial Bus) Power Mode – select Bus Powered, 100 mA 
Default values should be used for other parameters 
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Appendix V: START component dimensions & 
weights 

Table 21 - Physical properties of START Rover components 

Function Component Weight (g) 
Length (mm) 

Comments 
X Y Z 

Receiver u-blox NEO-M8T USB Dongle 16 75 26 13  

Receiver u-blox NEO-M8T High Gain: Pro Series 
(disc) 114 100 100 24 

with integrated 
antenna + ground 

plate 

Receiver u-blox NEO-M8T High Gain: X-Series 80 100 100 25 
with integrated 

antenna + ground 
plate 

Rover Control 
Computer ACEPC W5 Pro mini 52 114 40 15  

Rover Control 
Computer Intel Compute Stick 60 113 38 12  

Rover Battery 4400 mAH Batteries 115 95 46 22  

Rover Battery 5000 mAH Batteries 124 98 47 22  

Rover Battery 6000 mAH Batteries 148 99 47 22  

GNSS Antenna Tallysman 4721 72 38 38 14.3 use with PCB or 
Dongle receiver 

u-blox mount 45mm mounting plate (all plastic) 7     

u-blox mount 60mm mounting plate (all plastic) 10     
uBox mount 90mm mounting plate (all plastic) 12     

USB Filter Jitterbug USB Filter 10 39 19 13  
*USB interconnect cables not included 

 
Table 22 - START Rover configuration weights, as installed 

Typical Type 1 installation 
• u-blox NEO-M8T High Gain 
• 4400 mAH Battery 
• Intel Compute Stick 
• 45mm u-blox Mount 
• 90mm u-blox mount 
• Assorted cables, zip ties, velcro, and foam 
• Total with USB noise filter – 336g 
• Total without USB noise filter – 326g 

Typical Type 2 installation  
• u-blox NEO-M8T High Gain Disc 
• 4400 mAH Battery 
• ACEPC W5 Pro mini 
• 60mm u-blox Mount 
• Assorted cables, zip ties, velcro, and foam 
• Total with USB noise filter – 354g    
• Total without USB noise filter – 344g 
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Typical Type 1 installation - with 
longer life battery  

• u-blox NEO-M8T High Gain 
• 6000 mAH Battery 
• ACEPC W5 Pro mini 
• 45mm u-blox Mount 
• 90mm u-blox mount 
• Assorted cables, zip ties, velcro, and foam 
• Total with USB noise filter – 362g 
• Total without USB noise filter – 352g 

Typical Type 3 installation – separate 
antenna 

• u-blox NEO-M8T USB Dongle  
• Tallysman 4721 Antenna 
• 4400 mAH Battery 
• ACEPC W5 Pro mini 
• 45mm u-blox Mount 
• 90mm u-blox mount 
• Assorted cables, zip ties, velcro, and foam 
• Total wth USB noise filter – 355g  
• Total without USB noise filter – 345g 

Appendix VI: Product resource links 
1. u-blox M8: Receiver Description, including Protocol and Specifications Documentation: 

https://www.u-blox.com/sites/default/files/products/documents/u-blox8-
M8_ReceiverDescrProtSpec_%28UBX-13003221%29_Public.pdf 
 

2. u-blox u-center software download (includes User Guide in installation): 
https://www.u-blox.com/en/product-resources/field_file_category/evaluation-software-
222/field_file_products%253Afield_product_tech/raw-data-172 
 

3. RTK Explorer – very informative website and blog dealing with topics related to low cost GNSS 
receivers and  
RTKLIB software 
https://rtklibexplorer.wordpress.com/ 

  

https://www.u-blox.com/sites/default/files/products/documents/u-blox8-M8_ReceiverDescrProtSpec_%28UBX-13003221%29_Public.pdf
https://www.u-blox.com/sites/default/files/products/documents/u-blox8-M8_ReceiverDescrProtSpec_%28UBX-13003221%29_Public.pdf
https://www.u-blox.com/en/product-resources/field_file_category/evaluation-software-222/field_file_products%253Afield_product_tech/raw-data-172
https://www.u-blox.com/en/product-resources/field_file_category/evaluation-software-222/field_file_products%253Afield_product_tech/raw-data-172
https://rtklibexplorer.wordpress.com/
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  Appendix C: VerifyRINEX Data Dropout 
Summaries 

Mon Sep 27 08:24:26 
M600_1_210927_111839.obs 
---------------------------------------------- 
   5.7 sec gap between timestamps 2021-09-27 12:06:58.197 and 2021-09-27 12:07:03.896 
   2.0 sec gap between timestamps 2021-09-27 12:07:04.696 and 2021-09-27 12:07:06.703 
   2.0 sec gap between timestamps 2021-09-27 12:07:09.303 and 2021-09-27 12:07:11.293 
 
Mon Sep 27 09:25:58 
M600_2_210927_121419.obs 
---------------------------------------------- 
 219.8 sec gap between timestamps 2021-09-27 12:48:26.393 and 2021-09-27 12:52:06.199 
   2.6 sec gap between timestamps 2021-09-27 12:54:15.399 and 2021-09-27 12:54:17.990 
   4.7 sec gap between timestamps 2021-09-27 12:54:23.311 and 2021-09-27 12:54:27.999 
   2.2 sec gap between timestamps 2021-09-27 12:54:30.499 and 2021-09-27 12:54:32.696 
   0.3 sec gap between timestamps 2021-09-27 13:12:37.996 and 2021-09-27 13:12:38.296 
 
Mon Sep 27 22:12:29 
M600_6_210928_111806.obs 
---------------------------------------------- 
   1.9 sec gap between timestamps 2021-09-28 11:56:37.297 and 2021-09-28 11:56:39.199 
   1.9 sec gap between timestamps 2021-09-28 11:59:16.899 and 2021-09-28 11:59:18.794 
   1.9 sec gap between timestamps 2021-09-28 12:00:28.294 and 2021-09-28 12:00:30.192 
   1.9 sec gap between timestamps 2021-09-28 12:05:59.192 and 2021-09-28 12:06:01.098 
   1.9 sec gap between timestamps 2021-09-28 12:10:52.898 and 2021-09-28 12:10:54.803 
   2.0 sec gap between timestamps 2021-09-28 12:10:55.103 and 2021-09-28 12:10:57.089 
 
Mon Sep 27 23:06:13 
Transition_1_210928_124536.obs 
---------------------------------------------- 
 517.9 sec gap between timestamp 2021-09-28 13:40:47.101 and end of user window 
 
Wed Sep 29 17:17:13 
M600_8_210929_193238.obs 
---------------------------------------------- 
   2.0 sec gap between timestamps 2021-09-29 21:04:42.703 and 2021-09-29 21:04:44.697 
   0.3 sec gap between timestamps 2021-09-29 21:08:08.097 and 2021-09-29 21:08:08.397 
 



 
         JBCC UA Noise Measurement Report    110 

Wed Sep 29 18:52:30 
M600_9_210929_213829.obs 
---------------------------------------------- 
   1.8 sec gap between timestamps 2021-09-29 22:04:54.789 and 2021-09-29 22:04:56.591 
  21.1 sec gap between timestamps 2021-09-29 22:05:43.891 and 2021-09-29 22:06:04.991 
   1.8 sec gap between timestamps 2021-09-29 22:08:49.491 and 2021-09-29 22:08:51.289 
   1.8 sec gap between timestamps 2021-09-29 22:08:51.889 and 2021-09-29 22:08:53.699 
   1.7 sec gap between timestamps 2021-09-29 22:09:02.799 and 2021-09-29 22:09:04.496 
   2.9 sec gap between timestamps 2021-09-29 22:09:15.296 and 2021-09-29 22:09:18.202 
   1.7 sec gap between timestamps 2021-09-29 22:09:21.602 and 2021-09-29 22:09:23.304 
   2.0 sec gap between timestamps 2021-09-29 22:22:25.204 and 2021-09-29 22:22:27.206 
 228.6 sec gap between timestamps 2021-09-29 22:24:00.706 and 2021-09-29 22:27:49.295 
 170.0 sec gap between timestamps 2021-09-29 22:27:53.295 and 2021-09-29 22:30:43.290 
   0.5 sec gap between timestamps 2021-09-29 22:32:54.990 and 2021-09-29 22:32:55.490 
   0.5 sec gap between timestamps 2021-09-29 22:32:55.590 and 2021-09-29 22:32:56.090 
 
Wed Sep 29 20:59:33 
M600_9_210929_213829.obs 
---------------------------------------------- 
   1.8 sec gap between timestamps 2021-09-29 22:04:54.789 and 2021-09-29 22:04:56.591 
  21.1 sec gap between timestamps 2021-09-29 22:05:43.891 and 2021-09-29 22:06:04.991 
   1.8 sec gap between timestamps 2021-09-29 22:08:49.491 and 2021-09-29 22:08:51.289 
   1.8 sec gap between timestamps 2021-09-29 22:08:51.889 and 2021-09-29 22:08:53.699 
   1.7 sec gap between timestamps 2021-09-29 22:09:02.799 and 2021-09-29 22:09:04.496 
   2.9 sec gap between timestamps 2021-09-29 22:09:15.296 and 2021-09-29 22:09:18.202 
   1.7 sec gap between timestamps 2021-09-29 22:09:21.602 and 2021-09-29 22:09:23.304 
   2.0 sec gap between timestamps 2021-09-29 22:22:25.204 and 2021-09-29 22:22:27.206 
 228.6 sec gap between timestamps 2021-09-29 22:24:00.706 and 2021-09-29 22:27:49.295 
 170.0 sec gap between timestamps 2021-09-29 22:27:53.295 and 2021-09-29 22:30:43.290 
   0.5 sec gap between timestamps 2021-09-29 22:32:54.990 and 2021-09-29 22:32:55.490 
   0.5 sec gap between timestamps 2021-09-29 22:32:55.590 and 2021-09-29 22:32:56.090 
 
Thu Sep 30 10:38:34 
Transition_2_210930_115650.obs 
---------------------------------------------- 
   0.5 sec gap between timestamps 2021-09-30 13:52:52.710 and 2021-09-30 13:52:53.210 
 
Thu Sep 30 10:51:46 
M600_10_210930_134958.obs 
---------------------------------------------- 
   1.9 sec gap between timestamps 2021-09-30 14:24:04.303 and 2021-09-30 14:24:06.207 
   1.9 sec gap between timestamps 2021-09-30 14:36:26.007 and 2021-09-30 14:36:27.904 
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   1.9 sec gap between timestamps 2021-09-30 14:36:40.004 and 2021-09-30 14:36:41.911 
   1.9 sec gap between timestamps 2021-09-30 14:36:47.711 and 2021-09-30 14:36:49.594 
   2.9 sec gap between timestamps 2021-09-30 14:38:52.694 and 2021-09-30 14:38:55.600 
   2.0 sec gap between timestamps 2021-09-30 14:38:58.400 and 2021-09-30 14:39:00.395 
   3.3 sec gap between timestamps 2021-09-30 14:39:05.895 and 2021-09-30 14:39:09.200 
   6.1 sec gap between timestamps 2021-09-30 14:39:12.000 and 2021-09-30 14:39:18.099 
   2.0 sec gap between timestamps 2021-09-30 14:39:34.699 and 2021-09-30 14:39:36.710 
 
Thu Sep 30 12:37:43 
M600_11_210930_144501.obs 
---------------------------------------------- 
 361.8 sec gap between timestamps 2021-09-30 15:47:50.811 and 2021-09-30 15:53:52.593 
   2.3 sec gap between timestamps 2021-09-30 15:54:22.093 and 2021-09-30 15:54:24.399 
  66.3 sec gap between timestamps 2021-09-30 15:55:06.799 and 2021-09-30 15:56:13.094 
  29.9 sec gap between timestamps 2021-09-30 15:56:13.994 and 2021-09-30 15:56:43.892 
   2.3 sec gap between timestamps 2021-09-30 15:57:01.992 and 2021-09-30 15:57:04.291 
   2.8 sec gap between timestamps 2021-09-30 15:57:07.191 and 2021-09-30 15:57:09.998 
   3.8 sec gap between timestamps 2021-09-30 15:57:14.098 and 2021-09-30 15:57:17.891 
  49.0 sec gap between timestamps 2021-09-30 15:57:23.991 and 2021-09-30 15:58:13.003 
  90.2 sec gap between timestamps 2021-09-30 16:09:13.603 and 2021-09-30 16:10:43.798 
  65.7 sec gap between timestamps 2021-09-30 16:12:00.298 and 2021-09-30 16:13:05.997 
 172.9 sec gap between timestamps 2021-09-30 16:14:23.197 and 2021-09-30 16:17:16.106 
   1.8 sec gap between timestamps 2021-09-30 16:18:07.606 and 2021-09-30 16:18:09.389 
 
Thu Sep 30 15:53:35 
M210_3_210930_181239.obs 
---------------------------------------------- 
   0.5 sec gap between timestamps 2021-09-30 19:39:33.593 and 2021-09-30 19:39:34.093 
 
Thu Sep 30 17:48:02 
M210_4_210930_211646.obs 
---------------------------------------------- 
   0.3 sec gap between timestamps 2021-09-30 21:17:34.995 and 2021-09-30 21:17:35.295 
   0.4 sec gap between timestamps 2021-09-30 21:38:54.396 and 2021-09-30 21:38:54.796 
 
Fri Oct  1 11:35:27 
Phantom4_2_211001_141011.obs 
---------------------------------------------- 
   1.9 sec gap between timestamps 2021-10-01 14:23:15.901 and 2021-10-01 14:23:17.799 
   1.9 sec gap between timestamps 2021-10-01 14:25:59.999 and 2021-10-01 14:26:01.900 
   2.0 sec gap between timestamps 2021-10-01 14:42:23.401 and 2021-10-01 14:42:25.406 
   2.1 sec gap between timestamps 2021-10-01 14:42:35.206 and 2021-10-01 14:42:37.305 



 
         JBCC UA Noise Measurement Report    112 

   4.3 sec gap between timestamps 2021-10-01 14:43:40.505 and 2021-10-01 14:43:44.806 
  13.4 sec gap between timestamps 2021-10-01 14:43:46.706 and 2021-10-01 14:44:00.106 
   2.7 sec gap between timestamps 2021-10-01 14:44:02.106 and 2021-10-01 14:44:04.788 
   1.9 sec gap between timestamps 2021-10-01 14:44:06.088 and 2021-10-01 14:44:07.999 
   3.6 sec gap between timestamps 2021-10-01 14:44:09.499 and 2021-10-01 14:44:13.106 
   2.5 sec gap between timestamps 2021-10-01 14:44:17.306 and 2021-10-01 14:44:19.797 
   8.1 sec gap between timestamps 2021-10-01 14:44:27.297 and 2021-10-01 14:44:35.401 
   4.3 sec gap between timestamps 2021-10-01 14:44:38.501 and 2021-10-01 14:44:42.799 
   4.3 sec gap between timestamps 2021-10-01 14:44:55.399 and 2021-10-01 14:44:59.688
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11. Appendix D: Data Dictionary 
Table 23 - Full Data Dictionary Table 

Table Name Column Name Column Description DataTypeName MaxLength Is Nullable? In Identity? Key 
Description 

Aircraft Aircraft_ID Unique ID assigned to each aircraft model int 4 0 1 Primary Key 

Aircraft Aircraft_Name Aircraft Name varchar 8000 1 0  

Aircraft Aircraft_Type Description of Aircraft varchar 8000 1 0  

Master_List Index 
Index number of tables derived from the csv file listed in 

the File_Name column 
int 4 0 0 Primary Key 

Master_List Meter_Name Volpe designated name for the sound level meter system varchar 8000 1 0  

Master_List Drone_Name 
Name of aircraft recorded or designation for calibration 

and ambient recordings varchar 8000 1 0  

Master_List Test_Date Date that measurement file was recorded date 3 1 0  

Master_List File_Name 
Name of measurement file output by the sound level 

meter on the date in the Test_Date column by the SLM 
in the Meter_Name 

varchar 8000 1 0  

Master_List Wav_File_Path 
File path to the wav file recorded with the SLM file in the 

File_Name column 
varchar 8000 1 0  

Calibration_History Index 
Index number - reference to source file in Master_List 

table 
int 4 1 0 Foreign Key 

Calibration_History Pre_Amp 
Serial Number of the Pre-amplifier used with the system 
described by the Meter_Name in Master_List table - or 

direct input 
varchar 8000 1 0  

Calibration_History Date_Time Date and Time that calibration history was recorded varchar 8000 1 0  

Calibration_History dB re. 1V/Pa Nominal sensitivity of mic in dB at reference of 1V/Pa decimal 17 1 0  

Calibration_History 6.3 
Calibration noise level for 1/3 octave band centered on 

6.3 Hertz (dB) decimal 17 1 0  

Calibration_History 8 
Calibration noise level for 1/3 octave band centered on 8 

Hertz (dB) 
decimal 17 1 0  

Calibration_History 10 
Calibration noise level for 1/3 octave band centered on 

10 Hertz (dB) 
decimal 17 1 0  

Calibration_History 12.5 
Calibration noise level for 1/3 octave band centered on 

12.5 Hertz (dB) 
decimal 17 1 0  
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Calibration_History 16 
Calibration noise level for 1/3 octave band centered on 

16 Hertz (dB) 
decimal 17 1 0  

Calibration_History 20 
Calibration noise level for 1/3 octave band centered on 

20 Hertz (dB) 
decimal 17 1 0  

Calibration_History 25 Calibration noise level for 1/3 octave band centered on 
25 Hertz (dB) 

decimal 17 1 0  

Calibration_History 31.5 Calibration noise level for 1/3 octave band centered on 
31.5 Hertz (dB) 

decimal 17 1 0  

Calibration_History 40 
Calibration noise level for 1/3 octave band centered on 

40 Hertz (dB) decimal 17 1 0  

Calibration_History 50 
Calibration noise level for 1/3 octave band centered on 

50 Hertz (dB) 
decimal 17 1 0  

Calibration_History 63 
Calibration noise level for 1/3 octave band centered on 

63 Hertz (dB) 
decimal 17 1 0  

Calibration_History 80 
Calibration noise level for 1/3 octave band centered on 

80 Hertz (dB) 
decimal 17 1 0  

Calibration_History 100 
Calibration noise level for 1/3 octave band centered on 

100 Hertz (dB) 
decimal 17 1 0  

Calibration_History 125 
Calibration noise level for 1/3 octave band centered on 

125 Hertz (dB) 
decimal 17 1 0  

Calibration_History 160 
Calibration noise level for 1/3 octave band centered on 

160 Hertz (dB) 
decimal 17 1 0  

Calibration_History 200 
Calibration noise level for 1/3 octave band centered on 

200 Hertz (dB) 
decimal 17 1 0  

Calibration_History 250 
Calibration noise level for 1/3 octave band centered on 

250 Hertz (dB) 
decimal 17 1 0  

Calibration_History 315 Calibration noise level for 1/3 octave band centered on 
315 Hertz (dB) 

decimal 17 1 0  

Calibration_History 400 Calibration noise level for 1/3 octave band centered on 
400 Hertz (dB) 

decimal 17 1 0  

Calibration_History 500 
Calibration noise level for 1/3 octave band centered on 

500 Hertz (dB) decimal 17 1 0  

Calibration_History 630 
Calibration noise level for 1/3 octave band centered on 

630 Hertz (dB) 
decimal 17 1 0  

Calibration_History 800 
Calibration noise level for 1/3 octave band centered on 

800 Hertz (dB) 
decimal 17 1 0  

Calibration_History 1000 
Calibration noise level for 1/3 octave band centered on 

1000 Hertz (dB) 
decimal 17 1 0  

Calibration_History 1250 
Calibration noise level for 1/3 octave band centered on 

1250 Hertz (dB) 
decimal 17 1 0  
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Calibration_History 1600 
Calibration noise level for 1/3 octave band centered on 

1600 Hertz (dB) 
decimal 17 1 0  

Calibration_History 2000 
Calibration noise level for 1/3 octave band centered on 

2000 Hertz (dB) 
decimal 17 1 0  

Calibration_History 2500 Calibration noise level for 1/3 octave band centered on 
2500 Hertz (dB) 

decimal 17 1 0  

Calibration_History 3150 Calibration noise level for 1/3 octave band centered on 
3150 Hertz (dB) 

decimal 17 1 0  

Calibration_History 4000 
Calibration noise level for 1/3 octave band centered on 

4000 Hertz (dB) decimal 17 1 0  

Calibration_History 5000 
Calibration noise level for 1/3 octave band centered on 

5000 Hertz (dB) 
decimal 17 1 0  

Calibration_History 6300 
Calibration noise level for 1/3 octave band centered on 

6300 Hertz (dB) 
decimal 17 1 0  

Calibration_History 8000 
Calibration noise level for 1/3 octave band centered on 

8000 Hertz (dB) 
decimal 17 1 0  

Calibration_History 10000 
Calibration noise level for 1/3 octave band centered on 

10000 Hertz (dB) 
decimal 17 1 0  

Calibration_History 12500 
Calibration noise level for 1/3 octave band centered on 

12500 Hertz (dB) 
decimal 17 1 0  

Calibration_History 16000 
Calibration noise level for 1/3 octave band centered on 

16000 Hertz (dB) 
decimal 17 1 0  

Calibration_History 20000 
Calibration noise level for 1/3 octave band centered on 

20000 Hertz (dB) 
decimal 17 1 0  

Overall_Settings Index 
Index number - reference to source file in Master_List 

table 
int 4 1 0 Foreign Key 

Overall_Settings PeakWeight Weighting filter applied peak SPL varchar 8000 1 0  

Overall_Settings Detector Averaging method varchar 8000 1 0  

Overall_Settings Preamp 
Serial Number of the Pre-amplifier used with the system 
described by the Meter_Name in Master_List table - or 

direct input 
varchar 8000 1 0  

Overall_Settings MicrophoneCorrection Is microphone correction on or off varchar 8000 1 0  

Overall_Settings IntegrationMethod Integration Method Applied ('Linear' or 'Expoential') varchar 8000 1 0  

Overall_Settings OBARange 
Octave Band Analysis Range ('Low' or 'Normal'). Normal 

Range, typically 45 to 140 dB • Low Range, typically 19 to 
107 dB 

varchar 8000 1 0  

Overall_Settings OBABandwidth Octave Band Analysis Bandwidth (1/3, 1/12) varchar 8000 1 0  

Overall_Settings OBAFreq.Weighting Octave Band Analysis Frequency Weighting Filter Applied varchar 8000 1 0  



 
         JBCC UA Noise Measurement Report    116 

Overall_Settings OBAMaxSpectrum Octave Band Analysis Maximum Spectrum varchar 8000 1 0  

Overall_Settings Gain Input Gain (dB) varchar 8000 1 0  

Overall_Settings Overload Overload Level (dB Peak) decimal 17 1 0  

Session_Log Index 
Index number - reference to source file in Master_List 

table 
int 4 1 0 Foreign Key 

Session_Log Record # Unique ID for each index in record in Session_Log table 
by order of date and time 

int 4 1 0  

Session_Log Date Date on which session log record was recorded varchar 8000 1 0  

Session_Log Time Time at which session log record was recorded time 5 1 0  

Session_Log Record Type 
Indicates the selection of 'Run' or 'Stop' on Acoustic 

Measurement Device 
varchar 8000 1 0  

Session_Log Num N/A varchar 8000 1 0  

Session_Log TH Record Foreign Key to Record # in Time_History table int 4 1 0  

Session_Log Cause 
Indicates the action that causes the acoustic 

measurement device to perform the function in the 
Record Type field 

varchar 8000 1 0  

Time_History Index 
Index number - reference to source file in Master_List 

table 
int 4 1 0 Foreign Key 

Time_History Record # 
Unique ID for each index in record in Time_History table 

by order of date and time 
int 4 1 0  

Time_History Date Date on which Time History record was recorded date 3 1 0  

Time_History Time Time at which Time History record was recorded time 5 1 0  

Time_History LASeq Average Sound Level over Time period, A-weighted varchar 8000 1 0  

Time_History LASmax Maximum noise level, A-weighted varchar 8000 1 0  

Time_History LZSeq Average Sound Level over Time period, Z-weighted decimal 17 1 0  

Time_History Battery Battery level at Time of Recording decimal 17 1 0  

Time_History Int. Temp (F) Internal Temperature of SLM in degrees Fahrenheit decimal 17 1 0  

Time_History Wind Spd. Wind Speed in meters per second decimal 17 1 0  

Time_History Gust Dir. (° Degrees) Wind Gust Direction in Degrees decimal 17 1 0  

Time_History Avg Temp Average Temperature in degrees Fahrenheit decimal 17 1 0  

Time_History Avg Humidity Average Percent Humidity decimal 17 1 0  

Time_History 6.3 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 6.3 Hertz (dB LAS) 
decimal 17 1 0  
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Time_History 8 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 8 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 10 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 10 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 12.5 Half-second, A-weighted, slow time-averaged noise level 
for 1/3 octave band centered on 12.5 Hertz (dB LAS) 

decimal 17 1 0  

Time_History 16 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 16 Hertz (dB LAS) decimal 17 1 0  

Time_History 20 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 20 Hertz (dB LAS) decimal 17 1 0  

Time_History 25 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 25 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 31.5 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 31.5 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 40 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 40 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 50 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 50 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 63 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 63 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 80 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 80 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 100 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 100 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 125 Half-second, A-weighted, slow time-averaged noise level 
for 1/3 octave band centered on 125 Hertz (dB LAS) 

decimal 17 1 0  

Time_History 160 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 160 Hertz (dB LAS) decimal 17 1 0  

Time_History 200 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 200 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 250 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 250 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 315 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 315 Hertz (dB LAS) 
decimal 17 1 0  
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Time_History 400 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 400 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 500 Half-second, A-weighted, slow time-averaged noise level 
for 1/3 octave band centered on 500 Hertz (dB LAS) 

decimal 17 1 0  

Time_History 630 Half-second, A-weighted, slow time-averaged noise level 
for 1/3 octave band centered on 630 Hertz (dB LAS) 

decimal 17 1 0  

Time_History 800 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 800 Hertz (dB LAS) decimal 17 1 0  

Time_History 1000 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 1000 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 1250 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 1250 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 1600 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 1600 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 2000 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 2000 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 2500 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 2500 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 3150 Half-second, A-weighted, slow time-averaged noise level 
for 1/3 octave band centered on 3150 Hertz (dB LAS) 

decimal 17 1 0  

Time_History 4000 Half-second, A-weighted, slow time-averaged noise level 
for 1/3 octave band centered on 4000 Hertz (dB LAS) 

decimal 17 1 0  

Time_History 5000 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 5000 Hertz (dB LAS) decimal 17 1 0  

Time_History 6300 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 6300 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 8000 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 8000 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 10000 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 10000 Hertz (dB LAS) 
decimal 17 1 0  
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Time_History 12500 
Half-second, A-weighted, slow time-averaged noise level 

for 1/3 octave band centered on 12500 Hertz (dB LAS) 
decimal 17 1 0  

Time_History 16000 Half-second, A-weighted, slow time-averaged noise level 
for 1/3 octave band centered on 16000 Hertz (dB LAS) 

decimal 17 1 0  

Time_History 20000 Half-second, A-weighted, slow time-averaged noise level 
for 1/3 octave band centered on 20000 Hertz (dB LAS) 

decimal 17 1 0  

Time_History Gust Spd. 
Max wind speed collected over a one second interval - 

units depend on device settings decimal 17 1 0  

Time_History Max Temp Mximum Temperature - units depend on device settings decimal 17 1 0  

Time_History Min Temp Minimum Temperature - units depend on device settings decimal 17 1 0  

Time_History Weather4 Additional Weather Field (optional) decimal 17 1 0  

Time_History Ovrld. 
Indicates a preamp input signal that exceeds the 

calibrated range of the Acoustic Measurement device 
(yes/no) 

varchar 8000 1 0  

Time_History OBA Ovrld. 
Indicates input to Octave Band Analyzer has been 

overloaded (yes/no) 
varchar 8000 1 0  

Time_History Marker 
used to define the marker names and enable sound 

recorder options 
varchar 8000 1 0  

Time_History Key 
Indicates the key pushed on the acoustic measurement 

device at the time of the record 
varchar 8000 1 0  

Weather Index 
Index number - reference to source file in Master_List 

table 
int 4 1 0 Foreign Key 

Weather Avg Wind Speed(mi/h) 
Average Wind Speed over the interval of the time stamp 

in Miles per Hour 
decimal 17 1 0  

Weather Gust Speed(mi/h) 
Peak Wind Speed over the interval of the time stamp in 

Miles per Hour 
decimal 17 1 0  

Weather Min Wind Speed(mi/h) 
Minimum Wind Speed over the interval of the time 

stamp in Miles per Hour 
decimal 17 1 0  

Weather_Expanded Index 
Index number - reference to source file in Master_List 

table 
int 4 1 0 Foreign Key 

Weather_Expanded Avg Temp(°F) 
Average air temperature over time-history duration in 

degrees Fahrenheit 
decimal 17 1 0  

Weather_Expanded Max Temp(°F) Maximum air temperature over time-history duration in 
degrees Fahrenheit 

decimal 17 1 0  

Weather_Expanded Min Temp(°F) 
Minimum air temperature over time-history duration in 

degrees Fahrenheit decimal 17 1 0  

Weather_Expanded Avg Humidity(%RH) 
Average humidity over time-history duration in percent 

relative humidity 
decimal 17 1 0  
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Weather_Expanded Max Humidity(%RH) 
Maximum humidity over time-history duration in 

percent relative humidity 
decimal 17 1 0  

Weather_Expanded Min Humidity(%RH) 
Minimum humidity over time-history duration in percent 

relative humidity 
decimal 17 1 0  

Weather_Expanded Barometer Avg(hPa) Average barometric pressure over time-history duration 
in hectopascals 

decimal 17 1 0  

Weather_Expanded Barometer High(hPa) Maximum (high) barometric pressure over time-story 
duration in hectopascals 

decimal 17 1 0  

Weather_Expanded Barometer Low(hPa) 
Minimum (low) barometric pressure over time-history 

duration in hectopascals decimal 17 1 0  

Weather_Expanded Rain Accumulation(in) 
Cumulative accumulation of rainfall in inches in a 60 

squared cm area after the latest automatic or manual 
reset 

decimal 17 1 0  

Weather_Expanded Rain Max Rate(in/hr) 
Maximum rate of accumulation of rainfall in inches per 

hour decimal 17 1 0  

Weather_Expanded Rain Duration(s) 
Duration of Rainfall in seconds, counting each 10-second 

increment whenever droplet detected decimal 17 1 0  

Weather_Expanded 
Hail 

Accumulation(hits/in²) 
cumulative amount of hits against collecting surface in 

hits per squared inch 
decimal 17 1 0  

Weather_Expanded Hail Max Rate(hits/in²h) 
One-minute running average of hits per squared inch 

hour 
decimal 17 1 0  

Weather_Expanded Hail Duration(s) 
counting each 10-second increment whenever hailstone 

detected 
decimal 17 1 0  

Tracking Rec Tracking data record number int 4 1 0  

Tracking Source Tracking Sytem from which data was sourced varchar 8000 1 0  

Tracking Date UTC Date in mm/dd/yyyy format date 3 1 0  

Tracking Time 
UTC Time in yyy-mm-dd hh:mm:ss format (with 

erroneous date) 
time 5 1 0  

Tracking latitude(deg) Latitude position of aircraft in decimal degrees decimal 17 1 0  

Tracking longitude(deg) Longitude position of aircraft in decimal degrees decimal 17 1 0  

Tracking height(m) Height (z component) in meters decimal 17 1 0  

Tracking Q Quality Flag indicating solution quality varchar 8000 1 0  

Tracking ns 

Number of valid satellites 
1 : Fixed, solution by carrier-based relative positioning 

and the integer ambiguity is properly resolved. 2 : Float, 
solution by carrier-based relative positioning but the 

integer ambiguity is not resolved. 3 : Reserve 

int 4 1 0  

Tracking sdn(m) 
Standard deviation of north component of the solution 

in meters assuming a priori error model 
float 8 1 0  
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Tracking sde(m) 
Standard deviation of east component of the solution in 

meters assuming a priori error model 
float 8 1 0  

Tracking sdu(m) 
Standard deviation of up (height) component of the 

solution in meters assuming a priori error model 
float 8 1 0  

Tracking sdne(m) 
Square root of the standard deviation of North 
component in meters. Sign indicates the sign of 

covarience. 
float 8 1 0  

Tracking sdeu(m) 
Square root of the standard deviation of East component 

in meters. Sign indicates the sign of covarience. 
float 8 1 0  

Tracking sdun(m) 
Square root of the standard deviation of Up (height) 

component in meters. Sign indicates the sign of 
covarience. 

float 8 1 0  

Tracking age(s) 
Age of differential: The time difference between the 

observation data epochs of the rover receiver and the 
base station in seconds 

float 8 1 0  

Tracking ratio 

The ratio factor of "ratio-test" for standard integer 
ambiguity validation strategy. The value means the ratio 
of the squared sum of the residuals with the second best 

integer vector to with the best integer vector 

float 8 1 0  

Tracking UTC 
Time of day using Universal Coordinated Time (UTC) in 

hh:mm:ss format time 5 1 0  

Tracking TimeStamp 
Combined Date and Time, where date uses mm/dd/yyyy 

and time in UTC uses hh:mm:ss datetime 8 1 0  

Tracking y_0 Variable 1 used in offset angle calculation float 8 1 0  

Tracking x Variable 2 used in offset angle calculation float 8 1 0  

Tracking y Variable 3 used in offset angle calculation float 8 1 0  

Tracking x_local_m 
X coordinate in local coordinate system where primary 
microphone is (0, 0, 0) and +Y is the North direction on 

the flight path, in meters 
float 8 1 0  

Tracking y_local_m 
Y coordinate in local coordinate system where primary 
microphone is (0, 0, 0) and +Y is the North direction on 

the flight path, in meters 
float 8 1 0  

Tracking z_local_m 
Z coordinate in local coordinate system where primary 
microphone is (0, 0, 0) and +Y is the North direction on 

the flight path, in meters 
float 8 1 0  

Tracking x_local_ft 
X coordinate in local coordinate system where primary 
microphone is (0, 0, 0) and +Y is the North direction on 

the flight path, in feet 
float 8 1 0  
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Tracking y_local_ft 
Y coordinate in local coordinate system where primary 
microphone is (0, 0, 0) and +Y is the North direction on 

the flight path, in feet 
float 8 1 0  

Tracking z_local_ft 
Z coordinate in local coordinate system where primary 
microphone is (0, 0, 0) and +Y is the North direction on 

the flight path, in feet 
float 8 1 0  

Tracking x_RH_ft x position in feet adjusted to right hand rule convention float 8 1 0  

Tracking y_RH_ft y position in feet adjusted to right hand rule convention float 8 1 0  

Tracking SR_ft Slant range from source to origin in feet float 8 1 0  

Tracking Del_x_ft Change in x position between records in feet float 8 1 0  

Tracking Del_y_ft Change in y position between records in feet float 8 1 0  

Tracking Del_xy_ft Change in the resultant of xy between records in feet float 8 1 0  

Tracking GrndSpd_fps Ground speed in feet per second float 8 1 0  

Tracking GrndSpd_mph Ground Speed in miles per hour float 8 1 0  

Tracking GrndSpd_ms Ground Speed in meters per second float 8 1 0  

Tracking GrndSpd_kts Ground Speed in Knots float 8 1 0  

Tracking Aircraft_ID 
Aircraft unique ID - assigned when data is imported to 

database int 4 0 0 Foreign Key 

Tracking Aircraft_Name Aircraft Name varchar 8000 1 0  

 



 
 

 
           Document Title    123 

12. Appendix D: Volpe Aircraft Information 
Questionnaires 

(Please complete one form for each aircraft to be tested.) 

 
1. Vehicle manufacturer:___________________________________________ 
2. Vehicle model (and version):______________________________________ 
3. Modified?   yes  (if yes, describe on separate page)  no 
4. Vehicle configuration: 

 Rotorcraft: # of rotors_____ # of blades per rotor_____ 
  Rotor diameter_____ 
  Ducted?    yes   no 
  Co-axial, counter-rotating?  yes   no 

 Fixed-wing:  prop # of props____ 
    Configuration:  pusher 
       tractor 
       hybrid 
   otherspecify: (describe on separate page) 

 Hybrid: describe: (on separate page) 
5. Power method: 

 Electric 
 Internal combustion 
 gas turbine 
 hybrid describe: (on separate page) 
 otherdescribe: (on separate page) 

6. Flight Controls: 
 Movable aero surfaces 
 Differential thrust 
 Vectored thrust:  tilt-rotor 
    tilt-wing (or other mounting surface) 
    other  describe: (on separate page) 

7. Mass properties: 
Dry weight without payload____ 
Maximum TOW____ 
Maximum payload capacity____ 
CG Range Limits:  Lateral:____  Longitudinal:____ 

 
8. Size: 

Maximum dimension____  diameter 
     wingspan 
     length 
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     height 
     width 

9. Payload accommodation:   none 
 internal describe: (on separate page) 
 external describe: (on separate page) 

10.  Flight performance: 
 VTOL 
 STOL  
 CTOL (conventional horizontal flight) 
Are any external aids, mechanisms, or procedures required for Takeoff or Landing?
  yes  describe: (on separate page)   no 
Is there a physical transition to horizontal flight? 
  yes  describe: (on separate page)   no 

11.  Endurance: 
What is the maximum available flight duration between refueling/battery swaps? ____ 
Expected flight duration w/ 1-pound payload?____ 
What is the turnaround time for refueling / battery swap? ____ 
What is the availability of fuel refills / batteries?____ 
 

12. Altitude (ft. AGL) 
 Maximum Altitude ____ 
 Hover Altitude ____ 
 Operational Altitude ____ 
 Lower Altitude Limit (if applicable) ____ 

 
13. Speed 

 Vmax  ______ 

 VCruise _____ 

 Vmin (if applicable) ____ 
 VOperational _____ 

 
14. Please describe any other unique or unusual characteristics: (on separate page) 
 
If possible, please provide photos or technical drawings – overhead and profile. 
For clarification, comments, etc. please contact: 
 
Chris Cutler-Wood 
USDOT Volpe Center 
617-494-2817 (Massachusetts) 
Chris.Cutler-Wood@dot.gov  
 
  

mailto:Chris.Cutler-Wood@dot.gov
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13. Appendix E: Flight Event Communication 
Order of Operations 

1. Pilot confirms with Test Director go for takeoff  

2. (radio) Test Director announces takeoff  

3. AIRCRAFT TAKEOFF  

4. AIRCRAFT FLIES TO INITIAL START POSITION  

5. (radio) Test Director confirms with Pilot and announces upcoming Event ID  

6. AIRCRAFT BEGINS FLIGHT EVENT  

7. (radio) Test Director signals Data On  

8. Documentation Support FT logs “Data On” UTC timestamp  

a. Acoustics Support FT logs Data On UTC timestamp  

9. Documentation Support FT logs Time Overhead @ Mic Array  

a. Acoustics Support FT logs Time Overhead @ Mic Array  

10. Documentation Support FT logs “Data Off” UTC timestamp  

a. Acoustics Support FT logs “Data Off” UTC timestamp  

11. (radio) Test Director signals Data Off  

12. AIRCRAFT PAUSE/CIRCLE BEFORE NEXT EVENT  

13. Test Director confirms successful Event with Pilot & Acoustics Lead, marks Flight Card   

a. (radio) Acoustics Lead announces any system issues, or “acoustics system nominal”  

14. (radio) Test Director announces next Event ID  

15. AIRCRAFT BEGINS NEXT EVENT  

[repeat from Step 7]  
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14. Appendix F: Volpe Team Roles and 
Responsibilities Documentation 

Test Director  
The test director shall be responsible for the communication between all team members at a high level, 
before, during, and after the field measurements. The test director shall make the final decisions with 
respect to go/no-go criteria (weather, etc.) the night prior to each measurement day. During the 
measurements, the test director shall be in direct contact with the pilot(s) and the acoustics lead to ensure 
that the correct flight events have been flown, and that satisfactory acoustic data is captured for each 
event. The test director shall announce each flight event prior to execution and confirm with both the 
pilot and acoustics lead that the event was flown within acceptable limits and acoustic data was captured 
to a satisfactory level before moving on to the next flight event. The test director shall be responsible for 
decisions made with respect to which aircraft are flown during a particular measurement day, as well as 
which microphone array configuration to have set up.  
 

Acoustics Lead  
The acoustics lead shall be responsible for the successful operation of the NI / LabVIEW acoustics system, 
communication to the test director with respect to event data quality, and with the field technicians 
during setup and calibration. The acoustics lead shall be responsible for the setup of the table-based 
hardware for the NI / LabVIEW system including but not limited to the gain amplifiers, timecode 
generator, and solid-state storage media. The acoustics lead shall confer with the test director after 
acoustics system setup to confirm successful installation and operation of all acoustics system 
components prior to flight operations. The acoustics lead may call upon the acoustics support field 
technician to perform physical setup tasks as necessary. The acoustics lead will be in communication 
with acoustics support field technician to direct data downloads and post-event data quality checks, and 
hardware troubleshooting, as necessary. The acoustics lead will be in direct communication with the test 
director during the measurement, specifically to communicate the successful capture of acoustics 
data and reporting of overloaded data channels (if any) for each flight event before moving to the next 
flight event. The acoustics lead shall also be responsible for communication with any and all field 
technicians who may be assisting with pre- and post-test calibration recordings at the microphones. The 
acoustics lead has full authority to request a pause in flight operations and/or request repeat flight 
events at any point during the measurement if data collection and/or data quality has been 
compromised.  
 

Tracking System Lead  
The tracking system lead shall be responsible for the successful operation of the START tracking system 
used to capture high-quality satellite data from on-board the aircraft. The tracking system lead shall be 
responsible for the safe and secure mounting and installation of the START system on all aircraft to be 
flown during the measurement campaign. The tracking system lead shall be responsible for 
communicating any requirements for the safe and secure installation of START system hardware prior to 
each aircraft’s respective measurement day. The acoustics lead shall confer with the test director after 
acoustics system setup to confirm successful installation and operation of all START system components 
prior to flight operations.  The tracking system lead shall have authority to request a pause in flight 
operations in order to perform data quality checks as they deem necessary. The tracking system lead shall 
have authority to pause flight operations and/or request repeat flight events at any point in the 
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measurement if they determine the tracking data collection or data quality has been compromised. The 
tracking system lead shall be in communication with the test director and pilot(s) to determine which 
aircraft and at what point in time require the START system to be mounted and installed.  
 

Field Technicians  
All field technicians shall be capable of performing basic hardware setup and installation tasks related to 
the acoustics system. Such tasks may include (but are not limited to) ground plate installation, microphone 
cable running and coiling, microphone and preamp assembly, inverted microphone holder assembly and 
installation, and elevated mic array deployment. All field technicians shall also be capable of performing 
microphone calibration procedures at the direction of the acoustics lead. Field technicians may have 
specific support roles as well, described below.  
 

Acoustics Support  
Acoustics support field technicians shall be responsible for directly supporting the acoustics lead 
in the setup and operations of the NI / LabVIEW acoustics system. Acoustics support field 
technicians shall have a comparable understanding of the hardware and software components of 
the NI / LabVIEW system as the acoustics lead, so that they may assist the acoustics lead with any 
task as requested, including temporary operation of the NI / LabVIEW system, if necessary. During 
flight events, the acoustics support field technician shall be responsible for post-event acoustics 
data quality checks and communicating any potential data quality issues directly to the acoustics 
lead for consideration. The acoustics support field technician shall also be responsible for keeping 
a detailed log of relevant acoustics and flight event information such as overloads, data on/off 
times, and other general acoustics system notes. These log sheets will be considered backup to 
the primary logs captured by the documentation support field technician.  
 
Tracking Support  
Tracking support field technicians shall be responsible for directly supporting the tracking system 
lead in the setup and operations of the START tracking system. Tracking system field technicians 
shall have a comparable level of understanding of the hardware and software components of the 
START system as the tracking system lead so that they may assist the tracking system lead with 
any tasks as requested, including temporary operation of the START system, if 
necessary. During aircraft flight events, when the tracking system lead may not be available, the 
tracking support field technicians shall be responsible for the mounting, installation, and 
troubleshooting of the START system on aircraft scheduled to be flown.  
 
Documentation Support  
Documentation support field technicians shall be responsible for maintaining detailed log sheets 
of all relevant information during flight operations, including but not limited to, UTC times for 
event start/stop and aircraft overhead point, flight event description, flight event number, aircraft 
flown, weather conditions, anomalous test conditions (nearby sounds, wind gusts, talking during 
flight events, etc.). The documentation support field technician shall be positioned during the 
flight test to collect this information as easily as possible and shall be listening to any/all 
communication between the various team leads. The documentation support field technician 
shall be responsible for maintaining meticulous logs throughout each measurement day and 
sharing them with the full Volpe team at the end of each measurement day. The documentation 
support field technicians shall be responsible for collecting, digitizing, and organizing all other log 
sheets (such as the pilot/test director flight cards, calibration logs, tracking system logs) at the 
end of each measurement day and distributing to the full team.  
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15. Appendix G: AWRF Meteorological 
Analysis Slides 

 

AWRF Wind Speed Measurements
March 2019 – January 2020

Carl Snyder (V-345)
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